
H P  D e s k J e t  8 5 5 C  S e r i e s  P r i n t e r s M o d e l  N u m b e r  a n d  D e s c r i p t i o n 

Model Number and Description

HP DeskJet 855C Series Printers

Printer Name Model Numbers Availability Description

HP DeskJet 855C
Printer

C4551A US Only Fast black and color personal
printer for professionals.

HP DeskJet 855Cse
Printer

C4575A US Only Fast black and color personal
printer with additional software
bundle for professionals.

HP DeskJet 855Cxi
Printer

C4576A US Only Fast black and color personal
printer with additional bundle for
professionals.



H P  D e s k J e t  8 5 5 C  S e r i e s  P r i n t e r s F r o n t  V i e w 

Front View

2145001

Access Door

Resume Button & Light

Print Cartridge Latches

Print Cartridge Cradles

Single Sheet Feeder

IN Tray

Paper Width Adjuster

Paper Length Adjuster

Power Button & Light
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Rear View

Note When looking at the rear, the power plug is on the left side of
the printer.

Macintosh Interface Port

IEEE-1284 Interface Port (MS DOS/Windows)
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Ordering Printer Options

Printer Number and Language of Kits

Printer
Printer Option

Number
Language of Documentation

and Printer Software

HP DeskJet 855C Printer C4551A ABA English

HP DeskJet 855Cse Printer C4575A ABA English

HP DeskJet 855Cxi Printer C4576A ABA English

Power Cord, Documentation, and Software Kits

Printer
Power
Cord

User
Documentation

Kit

Macintosh
Printer

Software Kit

MS Windows
Printer

Software Kit

HP DeskJet 855C
Printer

8120-6177 C4551-60201 C2145-60250 C2145-60285

HP DeskJet 855Cse
Printer

8120-6177 C4551-60201 C2145-60250 C2145-60285

HP DeskJet 855Cxi
Printer

8120-6177 C4551-60201 C2145-60250 C2145-60285
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Items Included

HP DeskJet 855C

HP DeskJet 855C Printer with power cord

User's Guide and DOS Printing Guide

Printer software (diskettes)

One black and one color print cartridge

Media Sample Kit

HP DeskJet 855Cse

HP DeskJet 855Cse Printer with power cord

User's Guide, User’s Guide Errata Booklet, and DOS Printing
Guide

Printer software (diskettes)

One black and one color print cartridge

Media Sample Kit

Microsoft Publisher (Publisher 95) Version 3.0 (see below)

MS Shell (see below)

Kodak Promotion (see below)

HP DeskJet 855Cxi

HP DeskJet 855C Series Printer with power cord

User's Guide, User’s Guide Errata Booklet, and DOS Printing
Guide

Printer software (diskettes)

One black and one color print cartridge

Media Sample Kit

Kodak Promotion (see below)

Transparency Kit (see below)



H P  D e s k J e t  8 5 5 C  S e r i e s  P r i n t e r s I t e m s  I n c l u d e d 

Microsoft Publisher (Publisher 95), Version 3.0
(HP DeskJet 855Cse)

CD ROM for MS Windows 95 (no support for MS Windows 3.1)

Support provided by Microsoft

MS Shell (HP DeskJet 855Cse)

Getting started (printer setup, registration, what to do if you need
help)

HP Supplies (ink and media information)

Install Publisher

Using Color (tutorial for using color with Publisher)

Template Pack (predesigned brochures, flyers, leterhead, etc. for
use in Publisher.  User adds their own text and prints, or modifies
the layout if they wish).

MS Product Sampler (MS product info, including MS Office
information)

Kodak Promotion (HP DeskJet 855Cse and 855Cxi)

Pre-paid film mailer

5 sheets glossy media

5 sheets premium paper

Information packet to explain the promotion and photo contest.
(The customer sends their exposed film to Kodak in the pre-paid
mailer, Kodak sends the pictures back on CD-ROM along with
Kodak manipulation software. The photo contest may be entered
by printing a photo on a DeskJet 855 printer using glossy paper
and mailing it to Kodak.)

Transparency Kit (HP DeskJet 855Cxi)

A 20 sheet pack of transperancy films.
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Fonts Included

Scalable TrueType Fonts For MS Windows

Scalable TrueType Fonts For Macintosh
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Internal Fonts

All fonts included with the HP DeskJet 855C series printers are scalable
fonts. These fonts are available in portrait and landscape orientation.
There are no bitmapped fonts installed in the printer.

Internal Fonts (Scalable) Technology Treatment

Courier Intellifont Roman, Bold, Italic, Bold Italic

Letter Gothic Intellifont Roman, Bold, Italic, Bold Italic

CG Times Convergent Roman, Bold, Italic, Bold Italic

Univers Intellifont Text, Bold, Italic, Bold Italic

Times New Roman Convergent Text, Bold, Italic, Bold Italic

Arial Intellifont (TT) Text, Bold, Italic, Bold Italic

Symbol TrueType Symbol

Wingdings TrueType Symbol

Symbol Sets

    PC-8     HP Roman-8     Danish/Norwegian (60)

    PC-8 Danish/Norwegian     PC-8 Turkish     ANSI/ASCII (06)

    United Kingdom (04)     French (69)     German (21)

    Italian (15)     Spanish (17)     Swedish (11)

    PC-850 Multilingual     PC-852 Latin 2     ECMA-94 Latin 1 (8859/1)

    Legal     Windows Latin 1     ECMA-94 Latin 2 (8859/2)

    Windows Latin 2     Windows Latin 5     ECMA-128 Latin 5 (8859/5)
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Part Numbers

Item Description Part Number

Interface Cables DOS/MS Windows HP IEEE-1284 Parallel Interface
Cable (2 meter length)

C2950A

DOS/MS Windows HP IEEE-1284 Parallel Interface
Cable (3 meter length)

C2951A

Macintosh RS-422 Serial Cable 92215S

Macintosh AppleTalk Network Cable 92215N

HP Centronics Parallel Interface Cable C2912B or
HP24542D

Print Cartridges Black Inkjet Print Cartridge 51645A

Color Inkjet Print Cartridge 51641A

Media Premium Transparency Film (U.S. letter, 50 sheets) C3834A

Premium Transparency Film (U.S. letter, 20 sheets) C3828A

Premium Transparency Film (European  A4, 50 sheets) C3835A

Premium Transparency Film (European  A4, 20 sheets) C3832A

Premium Glossy Paper (U.S. letter, 50 sheets) C3836A

Premium Glossy Paper (U.S. letter, 10 sheets) C3833A

Premium Glossy Paper (European A4, 50 sheets) C3837A

Premium Glossy Paper (European A4, 10 sheets) C3831A

Premium InkJet Paper (U.S. letter, 200 sheets) 51634Y

Premium InkJet Paper (European A4, 200 sheets) 51634Z

Accessories HP PrinterPal Accessory C2970A

HP SupportPack Contact your local
dealer
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User Replaceable Components

Service Station Assembly (C2145-67901)

Paper Tray Assembly (C2145-67902)

Access Door (Top Cover) Assembly (C2145-67903)

Base Foot Assembly (4 ea.)
(C2162-60098) (Shown below
printer)
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Host/System Requirements

DOS/MS Windows

80386 or faster (MS Windows 3.1), 80286 or faster (DOS)

MS Windows 3.1 or MS Windows 95, or later

MS DOS, Version 3.3 or later

4 MB RAM

7.5 MB free hard disk space (1.5 MB - printer driver, 6.0 MB - fonts)

Macintosh QuickDraw Operation

System 7.0 or later

68020 16 MHZ or faster processor, 60040 25 Mhz recommended

At least 4 MB of RAM, 8 MB recommended

At least 10 MB free hard disk space

Macintosh QuickDraw GX Operation

System 7.5 or later

68020 16 MHZ or faster processor, 60040 25 Mhz recommended

At least 8 MB RAM, 12 MB recommended

At least 10 MB free hard disk space
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Driver Installation

For the printer to operate properly, a printer driver must be installed in your
computer. Refer to “Printer Driver Information/Installing the Printer Driver”
for more detailed information.
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Interface Specifications

HP DeskJet 855C series printers have two interface connectors to support
both DOS and Macintosh computers. The 36-pin Centronics style
connector is used with DOS/MS Windows based computers. The 8-pin
mini-circular DIN connector is used with Macintosh computers.

Note that only one connector can be active at a time. At power-up, the first
connector that senses active incoming data will be the dedicated I/O port.
The other connector will remain inactive.

Category DOS I/O Connector Macintosh I/O Connector

Communication Modes
Available

Compatible (Centronics)

Nibble

Byte

Extended Capabilities Port
(ECP)

RS-422 Serial (57.6 Kbaud)

AppleTalk (230.4 Kbaud)

High-Speed Externally-Clocked Serial
Mode

Supported Macintosh
Protocols

Serial Pacing Protocol (SPP)

AppleTalk Transaction Protocol (ATP)

AppleTalk Link Access Protocol (ALAP)

Datagram Delivery Protocol (DDP)

Echo Protocol (EP)

Name Binding Protocol (NBP)

Printer Access Protocol (PAP)

Routing Table Maintenance Protocol
(RTMP)

Compatible (standard Centronics) is the default communication mode

Printer Memory

Category Specification

Built-In ROM 2 MB

Built-In RAM 1 MB

Receive Buffer 32 Kbytes

Note For a complete description of your printer’s interface, see
“Printer Interface Information.”
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Product Performance Specifications

HP DeskJet 855C series printers print a true 600 DPI dot size.  In the
Normal mode, 300x300 data is sent which the printer REts to 600x600.
This happens very quickly because the conversion uses a hard-coded
table to convert to 600x600 rather than an on-the-fly algorithm.

In the Best mode, 600x600 data is sent to the printer and used directly.
Although somewhat slower than the Normal mode, this approach
produces the highest quality.

In either case, internal fonts are stored as outlines which are rendered
directly to 600x600 or 300x300 depending upon print mode.

Print Speed

Print
Mode

Black Printing
(No Graphics)

Color Printing (Mixed
Text and Graphics)

Color Printing
(Full-Page
Graphics)

Best 4 ppm 1 ppm 0.3 ppm

Normal 6 ppm 1.5 ppm 0.6 ppm

EconoFast 7 ppm 3 ppm 1 ppm
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Print Modes

Print
Mode

Plain Paper HP Premium Glossy Paper Transparency

EconoFast 300 x 300

1 Pass Color
1 Pass Black

N/A N/A N/A

Normal 1 300x300
Black (REt to
600x600)

300x300
Color  (with CREt)

2 Pass Color
1 Pass Black

300x300
Black (REt to
600x600)

300x300
Color  (with CREt)

4 Pass Color
3 Pass Black

300x300
Black (REt to
600x600)

300x300
Color  (with CREt)

4 Pass Color
3 Pass Black

300x300
Black (REt to
600x600)

300x300
Color  (with CREt)

4 Pass Color
3 Pass Black

Best 600 x 600
Black

300 x 300
Color

4 Pass Color
3 Pass Black

600 x 600
Black

300 x 300
Color

8 Pass Color
4 Pass Black

600 x 600
Black

300 x 300
Color

8 Pass Color
4 Pass Black

600 x 600
Black

300 x 300
Color

8 Pass Color
4 Pass Black

1.  In the Normal mode, a special Text/Lines mode is supported that optimizes performance and
quality when only  text and lines are present on the page.  The printer uses this mode on a page-
by-page basis if the following are true:

All text (of any color) is less than 24 pt.

All lines (of any color) are less than 4 pt. (including framed objects)

There are no more than 75 lines on the page

Only lines and text occur on the page.

DOS Graphics Resolution

75 dpi

150 dpi

300 dpi



H P  D e s k J e t  8 5 5 C  S e r i e s  P r i n t e r s P a p e r  H a n d l i n g 

Paper Handling

Category Specification

Paper Grain Long Grain Only

Paper Weight 16 to 36 lb (60 to 135 g/m2)

Envelope Weight 20 to 24 lb (75to 90 g/m2)

Card Stock Weight 110 lb Maximum, 8.5 pt Maximum Thickness
(110 to 200 g/m2)

IN Tray Capacity 150 Sheets of 20 lb Paper

Envelope Feeder Capacity Up to 15 Envelopes

OUT Tray Paper Capacity Up to 50 Sheets of 20 lb Paper

OUT Tray Envelope Capacity Up to 20

Single Sheet Capacity 1 Sheet at a Time

Card Stock Capacity Up to 30 Cards

Label Capacity Up to 25 Sheets
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Supported Media/Sizes

Media English Size Metric Size

U.S. Letter 8 1/2 in. x 11 in. 215.9 mm x 279.4 mm

U.S. Legal 8 1/2 in. x 14 in. 215.9 mm x 355.6 mm

U.S. Executive 7 1/4 in. x 10 1/2 in. 184.1 mm x 266.7 mm

ISO & JIS A4 8.27 in. x 11.69 in. 210 mm x 297 mm

ISO & JIS A5 5.85 in. x 8.27 in. 148.5 mm x 210 mm

JIS B5 7.17 in. x 10.12 in. 182 mm x 257 mm

U.S. No. 10 Envelope 4 1/8 in. x 9 1/2 in. 104.8 mm x 241.3 mm

International DL Envelope 4.33 in. x 8.66 in. 110 mm x 220 mm

International C6 Envelope 4.49 in. x 6.38 in. 114 mm x 162 mm

U.S. Size Card Stock 4 in. x 6 in. 101.6 mm x 152.4 mm

U.S. Size Card Stock 5 in. x 8 in. 127 mm x 203.2 mm

ISO & JIS A6 Postcard 4.13 in. x 5.85 in. 105 mm x 148.5 mm

Japanese Hagaki Postcard 3.94 in. x 5.83 in. 100 mm x 148 mm

Custom Minimum Size 3.94 in. x 5.83 in. 100 mm x 148 mm

Custom Maximum Size 8.5 in. x 14 in. 216 mm x 356 mm

U.S. Transparency 8 1/2 in. x 11 in. 215.9 mm x 279.4 mm

European Transparency 8.27 in. x 11.69 in. 210 mm x 297 mm

U.S. glossy 8 1/2 in. x 11 in. 215.9 mm x 279.4 mm

European A4 glossy 8.27 in. x 11.69 in. 210 mm x 297 mm

Special U.S. 8 1/2 in. x 11 in. 215.9 mm x 279.4 mm

Special A4 8.27 in. x 11.69 in. 210 mm x 297 mm

U.S. lables 8 1/2 in. x 11 in. 215.9 mm x 279.4 mm

European lables 8.27 in. x 11.69 in. 210 mm x 297 mm
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Printable Areas

U.S. Paper

Supported Media

Media Media Size Printable Area

U.S. Letter 8.5 in. X 11 in.
(215.9 mm X 279.4 mm)

8.0 in. X 10.50 in.
(203.2 mm X 266.7 mm)

U.S. Legal 8.5 in. X 14 in.
(215.9 mm X 355.6 mm)

8.0 in. X 13.50 in.
(203.2 mm X 342.9 mm)

U.S. Executive 7.25 in. X 10.5 in.
(184.1 mm X 266.7 mm)

6.75 in. X 10.00 in.
(172.5 mm X 254.0 mm)

Margins (Portrait Orientation)

Media Top Bottom Lef t Right

U.S. Letter 0.04 in.
(1.0 mm)

0.46 in.
(11.7 mm)

0.25 in.
(6.3 mm)

0.25 in.
(6.3 mm)

U.S. Legal 0.04 in.
(1.0 mm)

0.46 in.
(11.7 mm)

0.25 in.
(6.3 mm)

0.25 in.
(6.3 mm)

U.S.
Executive

0.04 in.
(1.0 mm)

0.46 in.
(11.7 mm)

0.25 in.
(6.3 mm)

0.25 in.
(6.3 mm)
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A4, A5, B5 Paper

Supported Media

Media Media Size Printable Area

ISO & JIS A4 8.27 in. X 11.69 in.
(210mm X 297 mm)

8.0 in. X 11.19 in.
(203.2 mm X 284.3 mm)

ISO & JIS A5 5.83 in. X 8.27 in.
(148mm X 210 mm)

5.57 in. X 7.77 in.
(141.6 mm X 197.3 mm)

JIS B5 7.17 in. X 10.12 in.
(182 mm X 257mm)

6.91 in. X 9.62 in.
(175.6 mm X 244.3 mm)

Margins (Portrait Orientation)

Media Top Bottom Lef t Right

ISO &
JIS A4

0.04 in.
(1.0 mm)

0.46 in.
(11.7 mm)

0.13 in.
(3.44 mm)

0.13 in.
(3.44 mm)

ISO &
JIS A5

0.04 in.
(1.0 mm)

0.46 in.
(11.7 mm)

0.13 in.
(3.44 mm)

0.13 in.
(3.44 mm)

JIS B5 0.04 in.
(1.0 mm)

0.46 in.
(11.7 mm)

0.13 in.
(3.44 mm)

0.13 in.
(3.44 mm)
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Card Stock

Supported Media

Media Media Size Printable Area

U.S. Card Stock 4 in. X 6 in.
(101.6 mm X 152.4mm

3.75 in. X5.50 in.
95.3 mm X 139.7 mm)

U.S. Card Stock 5 in. X 8 in.
(127.0 mm X 203.2 mm)

4.75 in. 7.50 in.
(120.7 mm X 190.5 mm)

ISO & JIS A6 Cards 4.13 in. X 5.83 in.
(105 mm X 148 mm)

3.88 in. X 5.34 in.
(98.6 mm X 135.3 mm)

Japanese Hagaki Postcard 3.94 in. X 5.85 in.
(100 mm X 148.5 mm)

3.69 in. X 5.33 in.
(93.6 mm X 135.3 mm)

Margins (Portrait Orientation)

Media Top Bottom Lef t Right

U.S. Card Stock 0.04 in.
(1.0 mm)

0.46 in.
(11.7 mm)

0.125 in.
(3.2 mm)

0.125 in.
(3.2 mm)

U.S. Card Stock 0.04 in.
(1.0 mm)

0.46 in.
(11.7 mm)

0.125 in.
(3.2 mm)

0.125 in.
(3.2 mm)

ISO & JIS A6 Cards 0.04 in.
(1.0 mm)

0.46 in.
(11.7 mm)

0.125 in.
(3.2 mm)

0.125 in.
(3.2 mm)

Japanese
Hagaki Postcard

0.04 in.
(1.0 mm)

0.46 in.
(11.7 mm)

0.125 in.
(3.2 mm)

0.125 in.
(3.2 mm)
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Envelopes

Supported Media

Media Media Size Printable Area

No. 10 Envelope 4.125 in. X 9.5 in.
(104.8 mm X 241.3 mm)

3.88 in. X 8.59 in.
(98.4mm X 218.3 mm)

International DL Envelope 4.33 in. X 8.66 in.
(110 mm X 220 mm)

4.08 in. X 7.76 in.
(103.6 mm X 197.0 mm)

International C6 Envelope 4.49 in. X 6.38 in.
(114 mm X 162 mm)

4.24 in. X  5.47 in.
(107.6 mm X 139.0 mm)

Margins (Portrait Orientation)

Media Top Bottom Lef t Right

No. 10 Envelope 0.125 in.
(3.2 mm)

0.125 in.
(3.2 mm)

0.87 in.
(22.0 mm)

0.04 in.
(1.0 mm)

International
DL Envelope

0.125 in.
(3.2 mm)

0.125 in.
(3.2 mm)

0.87 in.
(22.0 mm)

0.04 in.
(1.0 mm)

International
C6 Envelope

0.125 in.
(3.2 mm)

0.125 in.
(3.2 mm)

0.87 in.
(22.0 mm)

0.04 in.
(1.0 mm)

Note The bottom margin is the left side (return address side) of the
envelope.
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Custom Page

Minimum Page Size Margins

Width Length Top Bottom Lef t Right

3.94 in.
(100 mm)

5.83 in.
(148mm)

0.04 in.
(1.0 mm)

0.46 in.
(11.7 mm)

0.13 in.
(3.44 mm)

0.13 in.
(3.44 mm)
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Physical Specifications

Weight: 6.5 kg (14.3 lb.)
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Electrical Specifications

Category Specification

Input Voltage 100 VAC-240 VAC ± 10%

Frequency 50/60 Hz ± 3 Hz

Power consumption 0.25 Watts (Off)
5.25 Watts (Idle)
48 Watts Maximum (Printing)
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Environmental Specifications

Attributes Specification

Operating temperature 5 ∞C to 40 ∞C (41 ∞F to 104 ∞F)

Optimum temperature 15 ∞C to 35 ∞C (59 ∞F to 95 ∞F)

Storage temperature -40 ∞C to 60 ∞C (-40 ∞F to 140 ∞F)

Operating humidity
  (noncondensing)

20% to 80% relative humidity,
maximum wet bulb 35 ∞C  (95 ∞F)

Storage humidity
  (noncondensing)

15% to 80% relative humidity,
maximum wet bulb 60 ∞C  (140 ∞F)

Noise Levels ISO 92961

  Sound Power, LWAd:
  Sound Pressure, LPAm:

Best Mode          EconoFast Mode
6.4 B(A)               6.4 B(A)
51 dB(A)              52 dB(A)

Altitude
  Operating
  Nonoperating

3,048 m (10,000 ft) maximum
4,572 m (15,000 ft) maximum

Mechanical vibration
  Frequency range
  Operating (random)
  Nonoperating (random)
  Swept sine

5 to 500 Hz
Approximately 0.21 G rms
Approximately 2.09 G rms
0.5 G (0 to peak)

Thermal output 164 BTU/hour (maximum)

1. Bystander position

Optimal Operating Conditions
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Safety and EMI Specifications

Category Specification

Safety
certifications

UL, CSA, ETL, KEMA, TUV, SEMKO, NEMKO, FIMKO, DEMKO, NOM

EMI
certifications

USA: FCC Part 15, Class B, when used with a Class B computing Device
Japan: VCCI Class 2
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Reliability Specifications

Category Specification

Printer usage rate 1,000 Pages per Month (Black)
160 Pages per Month (Color)

Mean time between failures
(MTBF)

20,000 hours
(2,000 hours Power On and 12,000 Printed Pages per Year)

Mechanism life 60,000 Pages
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Packaging Specifications

Weight: 8.432 kg (18.59 lb.)



General Refilling Policy

Caution The ink in the print cartridges has been carefully formulated
by Hewlett-Packard to ensure superior print quality and
compatibility with the printer. Damage to the printer resulting
from modifying the print cartridge is not the responsibility of
Hewlett-Packard.

Hewlett-Packard does not support the refilling of print car-
tridges. Hewlett-Packard cannot guarantee the print quality
from refilled print cartridges. Attempting to refill the high-
capacity print cartridge may result in a sudden loss of ink from
the print cartridge. Printer damage caused by refilling high-
capacity black ink or color ink print cartridges is not covered
by the Hewlett-Packard warranty or customer service
agreements.



Part Numbers

Part Number Description

51641A Color Inkjet Print Cartridge
(Cyan, Magenta, and Yellow Inks)

51645A High Capacity Inkjet Print Cartridge (Black)



Print Cartridge Specifications

Specification Hewlett-Packard Print Cartridges

Type Plain paper drop-on-demand
Thermal InkJet printing

Ink Base
51645A (Black)
51641A (Color)

Pigment Based Ink
Dye Based Ink

Print Cartridge Life
51645A (Black)1

51641A (Color)2
840 Pages at 5% Density
460 Pages at 15% Density

Typical Usable Ink
51645A (Black)
51641A (Color)

41 ml
16 ml per Chamber

Number of Nozzles
51645A (Black)
51641A (Color)

300 Nozzles
192 Nozzles (64 per Color)

Pen Speed
51645A (Black)
51641A (Color)

12 kHz
6 kHz

Shelf Life 18 Months

Vertical Resolution 300 dpi

1. The 51645A print cartridge life is based on an 8 in. x 10 in. printable area with a 5% printing
density.

2. The 51641A print cartridge life is based on an 8 in. x 10 in. printable area with a 15% printing
density. The printing consists of 10% composite black and 15% of the following colors: cyan,
magenta, yellow, green, red and blue.



Thermal Inkjet Technology

The HP DeskJet printer family uses Thermal InkJet II (TIJ II) technology.
This technology centers on a disposable print cartridge which propels ink
out of 300 nozzles (192 nozzles on the color print cartridge). The basic
principle of TIJ II is to apply heat to a tiny measure of ink until it expands
and is propelled through a nozzle.

This is achieved by first filling a small reservoir, known as the firing
chamber, with ink. The next step is to heat the ink with a thin-film resistor
layered above the firing chamber. As the ink heats up, it expands to form a
bubble. As the bubble continues to expand and burst, it is forced through
the nozzle located below the firing chamber.

This process is repeated up to 12,000 times per second and creates
residual heat in the resistor which must be removed. A layer of silicon
placed above the resistor transfers the residual heat from the resistor.



Print Cartridge Safety

If ink is accidentally ingested, contact the HP Health Line
1 (800) 457-4209 in North America. From all other international
locations the HP Health Line can be reached by calling
1 (503) 494-7199. For health related issues, this line is staffed
24 hours per day.

Material Safety Data Sheet (MSDS)

A Material Safety Data Sheet (MSDS) is available for the print car-
tridges. The MSDS includes product identification, characteristics of
the ink, and precautions for handling and use. You can request a
MSDS at the following address:

Hewlett-Packard Customer Information Center
Department MSDS
19310 Pruneridge Avenue
Cupertino, CA 95014
Mailstop 49AS

Telephone 1 (800) 752-0900
Ask for Department MSDS (6:00 AM to 5:00 PM Pacific Time)

The Material Safety Data Sheet is also available from the following
sources:

HP forums of electronic bulletin board services

HP FIRST

Customer Support Centers

Refer to “Service and Support/Resources” for access to the above
resources.



Maintaining Print Cartridges

The printer automatically performs operations of spitting, wiping, and
capping of the print cartridge nozzles to maintain optimum print quality.
These operations occur transparently to the user.

Proper use and handling will provide optimum print quality and print
cartridge life.

Note See “Print Cartridge Information/Maintenance and
Troubleshooting” for more print cartridge troubleshooting
information.

Print Cartridge Tips

Print Cartridge Dos and Don’ts

Do: Don’t:

Keep print cartridges sealed in their packaging
until ready for use. (The print cartridges have a
longer life sealed in the packaging than in the
printer or the print cartridge storage container.)

Do not use print cartridges after the expiration
date. See “Print Cartridge Information/
Maintenance and Troubleshooting”.

Keep opened print cartridges in the printer. Do not unplug the printer without turning the
power off from the power button. Pressing the
power button caps the print cartridge in the
service station, keeping the ink from drying in
the print cartridge nozzles.

If the printout is missing dots or white lines
appear to run through the printout, refer to
“Troubleshooting Information/Print Quality
Problems/Missing Dots”.

Do not allow the print cartridge contacts and
nozzles to touch any surface or object,
including your fingers. Skin oil and dust can
cause print quality problems.

Store print cartridges at room temperature. Do not install a print cartridge that has crusting
of dried ink around the print cartridge nozzles.
Discard it and install a new print cartridge.

Press the Power button to turn off the printer
rather than unplugging the printer.

Note On the HP DeskJet 850 Printer, opening the access door
automatically moves the print cartridge to the center of the
mechanism for easy access.



Modifying or Refilling Print Cartridges

See “Print Cartridge Information/General/Refilling Policy”.



Identifying the Expiration Date

Print quality problems may be caused by print cartridges that have passed
their expiration date. The print cartridge expiration date is 18 months after
the date of manufacture.

Methods for Identifying Print Cartridge
Expiration Dates

Method 1 - Read the Date on the Box
If the print cartridge is in a box, read the “Use Before” date printed on the
box.



Method 2 - Read the Code on the Print Cartridge

1. Determine the manufacturing date from the code printed on the print
cartridge.

2. Replace the print cartridge if it is more than 18 months after the
manufacturing date code.

Note Ink can evaporate through the nozzles, reducing the print
cartridge life. Therefore, keep print cartridges in their sealed
container or capped by the service station at the right end of
the mechanism.

Use a FIFO (First In, First Out) inventory control process to
avoid having print cartridges longer than the print cartridge
shelf-life specification.

51641A (Color)

51645A (Black)



Short Print Cartridge Life

There are several causes for a short print cartridge life. The information
below identifies the average print cartridge life and possible causes for a
reduction to this cartridge life.

Print Cartridge Life Specifications

Print Cartridge Part Number 5% Density 15% Density

Sealed in its
Container
(Shelf Life)

Black 51645A 840 Pages 18 Months

Color 51641A 560 Pages 18 Months

1. The 51645A print cartridge life is based on an 8 in. x 10 in. printable area with a 5% printing
density.

2. The 51641A print cartridge life is based on an 8 in. x 10 in. printable area with a 15% printing
density. The printing consists of 10% composite black and 15% of the following colors: cyan,
magenta, yellow, green, red and blue.

Possible Causes for Short Print Cartridge Life

Cause Reason

Higher coverage rate than
listed in the
specifications

The rate of coverage on the page significantly impacts the number
of pages per print cartridge. Heavy concentrations of ink and higher
print quality settings significantly reduce the number of pages per
print cartridge.

Pages contain graphics Generally, graphics use ink at a much higher rate than text. If
possible, print drafts of documents without the graphics.

Selected print mode Higher quality print modes use more ink than a draft print mode. To
maximize print cartridge life, print drafts of documents in EconoFast
mode, then print the final copies in Best mode.

Print cartridge past its
expiration date

Replace the print cartridge. Use a FIFO (First In-First Out) inventory
process to minimize having a stock of expired print cartridges.

Continued on next page



Possible Causes for Short Print Cartridge Life (Cont.)

Cause Reason

Printer unplugged with the
print cartridge out of its home
position

A service station is located at the right end of the mechanism.
This service station caps the print cartridge nozzles to minimize
ink drying in the nozzles. Turning off the printer caps the print
cartridge and returns it to the service station. Always allow the
print cartridge to return to the home position by pressing the
Power button rather than unplugging the printer.

Print cartridge may need to
be restored

Run the print cartridge cleaning routine. If print quality is not
restored after a page of printing, replace the print cartridge.

Excessive use of the print
cartridge cleaning routine

The process of restoring print cartridges by running the cleaning
routine uses ink. Avoid excessive use of the cleaning routine.

Print cartridge stored outside
of the printer

Open print cartridges must be stored in the printer.

Refilled print cartridge Hewlett-Packard does not recommend or guarantee the print
quality or life from the refilling of print cartridges. Replace the
print cartridge with a new print cartridge.

Print cartridge prematurely
removed from its sealed
container

The print cartridge has a longer life sealed in its packaging than
in the printer or the print cartridge storage container. Keep print
cartridges sealed in their packaging until needed. Then, install
the print cartridge promptly into the printer.

Incorrect estimate of pages
printed with the print
cartridge

It is very easy to underestimate the number of pages printed.
When counting pages per cartridge, be sure to count drafts that
are thrown away.

Faulty print cartridge Replace the print cartridge. If there becomes a pattern of faulty
print cartridges, the printer may be causing the print cartridges
to fail. In this case, return the printer for repair and indicate the
history of the faulty print cartridges.

Printer hardware problem The service station may be faulty, or the printer may be
damaging the print cartridges. If the problem recurs with the
printer, return the printer for repair and indicate the history of the
faulty print cartridges.

Short color print cartridge life Most of the causes for short black print cartridge life also apply
to the color print cartridge. Review the other possible causes in
this table.



Print Cartridge Cleaning Routine

If rows of dots are missing on printouts, try cleaning the print cartridge by
using the print cartridge cleaning routine in the printer. Refer to
"Troubleshooting Information/Printer Diagnostic Information/Print Cartridge
Cleaning".



Clearing Clogged Nozzles

If rows of dots are missing, if the print cartridge contains ink, and if the print
cartridge cleaning procedure did not solve the problem, the print cartridge
may have clogged nozzles. Replace the print cartridge.



Printout Missing Dots

Horizontal rows of dots missing on printouts may be the result of a
connection problem between the printer carriage contacts and the print
cartridge contacts. For information about solving missing dot problems,
refer to "Troubleshooting Information/Print Quality Problems/Missing Dots".



Print Quality Problems

Refer to "Troubleshooting Information/Print Quality Problems/Misc. Print
Quality Problems".



Media Part Numbers

The following are general guidelines for the selection and loading of
paper and media in HP DeskJet and DeskWriter printers. For information
about your specific printer, refer to “User’s Guide/Printable Area and Paper
Handling.”

HP Media Part Numbers

Product
Name

Description Dimensions Package
S i z e

Par t
Number

HP Premium
Inkjet Paper
(Not for use
with photo pen)

U.S. Letter/A-size coated paper
for premium DeskJet printing

216 x 279 mm
(8.5 x 11 in)

200
sheets

51634Y

HP Premium
Inkjet Papern
(Not for use
with photo pen)

European/A4-size coated paper
for premium DeskJet printing

210 x 297 mm 200
sheets

51634Z

HP Premium
Transparency
Film

U.S. Letter/A-size transparency
film for presentation-quality
overheads

216 x 279 mm
(8.5 x 11 in)

20 sheets C3828A

HP Premium
Transparency
Film

European/A4-size transparency
film for presentation-quality
overheads

210 x 297 mm 20 sheets C3832A

HP Premium
Transparency
Film

U.S. Letter/A-size transparency
film for presentation-quality
overheads

216 x 279 mm
(8.5 x 11 in)

50 sheets C3834A

HP Premium
Transparency
Film

European/A4-size transparency
film for presentation-quality
overheads

210 x 297 mm 50 sheets C3835A

HP Premium
Glossy Paper

U.S. Letter/A-size glossy paper 216 x 279 mm
(8.5 x 11 in)

10 sheets C3833A

HP Premium
Glossy Paper

European/A4-size glossy paper 210 x 297 mm 10 sheets C3831A

HP Premium
Glossy Paper

U.S. Letter/A-size glossy paper 216 x 279 mm
(8.5 x 11 in)

50 sheets C3836A

HP Premium
Glossy Paper

European/A4-size glossy paper 210 x 297 mm 50 sheets C3837A

HP Greeting
Card Paper

A-size paper and matching
envelope for Quarter fold cards

216 x 279 mm
(8.5 x 11 in)

20 ea C1812A

Continued on next page



HP Media Part Numbers (Cont.)

Product
Name

Description Dimensions Sheets
per Pack

Par t
Number

HP Bright
White InkJet
Paper

U.S. Letter/A-size treated paper
great for two-sided printing

216 x 279 mm
(8.5 x 11 in)

500
sheets

C1824A

HP Bright
White InkJet
Paper

European/A4-size treated paper
great for two-sided printing

210 x 297 mm 500
sheets

C1825A

HP Banner
Paper1

U.S. Letter/A-size Z-Fold, both-
side printable

216 x 279 mm
(8.5 x 11 in)

100
sheets

C1820A

HP Banner
Paper1

European/A4, Z-fold, both-side
printable

210 x 297 mm 100
sheets

C1821A

HP Photo
Paper2

U.S. Letter/A-size glossy paper
great for photos

216 x 279 mm
(8.5 x 11 in)

20 sheets C1846A

HP Photo
Paper2

European/A4-size glossy paper
great for photos

210 x 297 mm 20 sheets C1847A

HP Photo
Paper Greeting
Card (Available
Spring ‘97)2

U.S. Letter/A-size glossy paper
great for photos

216 x 148.5
mm

(8.5 x 5.5 in)

20 sheets C1848A

HP Photo
Paper Greeting
Card (Available
Spring ‘97)2

European/A4-size glossy paper
great for photos

210 x 297 mm 20 sheets C1849A

HP Photo
Paper Invite
Card (Available
Spring ‘97)2

Glossy paper and matching
envelopes for half-fold Invite
Card with two-sided printing

216 x 148.5
mm

(8.5 x 5.5 in)

20 sheets C1850A

HP Photo
Paper Invite
Card (Available
Spring ‘97)2

Glossy paper and matching
envelopes for half-fold Invite
Card with two-sided printing

148 x 210 mm 20 sheets C1851A

1. Verify through your User’s Guide the applicability of using banner paper with your printer.

2. Verify through your User’s Guide the applicability of using photo paper with your printer.



Selecting Paper Tips

Tips for Selecting and Using Paper

For paper handling and printable area specifications, refer to
“Product Information/Specifications.”

Always use paper that conforms to the product’s specifications.
Refer to “Product Information/Specifications.”

Most plain paper manufactured for photo-copying produces good
results for most printing needs.  However, cotton bond paper, HP
Premium Inkjet Paper, and HP Premium Glossy Paper produce
excellent printing results for special projects.

Before you purchase large quantities of a certain type of paper,
print on both sides of a few sheets to determine if it provides
acceptable quality printing on its "print side." (See "Determining
the Print Side of Media.")

Be sure that your paper does not have tears, dust, wrinkles, or
curled or bent edges.

Tips for Selecting and Using Envelopes

Always use envelopes that conform to the product’s Specifications.
Refer to “Product Information/Specifications.”

Before you purchase large quantities of a certain type of envelope,
first sample its ease of use with the printer to determine whether
it's compatible.

Use high quality envelopes that are thin and sharply creased.

Do not use envelopes that are shiny or embossed or that have
clasps or windows.

Do not use envelopes with thick or crooked edges, or envelopes
that are damaged, curled, wrinkled, or irregularly shaped.



Tips for Selecting and Using Transparencies and
other Media

Always use transparencies, index cards, postcards, and other
media that conform to the product’s Specifications.  Refer to
“Product Information/Specifications.”

For best results when printing on transparencies, use HP Premium
Transparency Film.

Do not use paper that is damaged, curled, or wrinkled.

Do not use paper with cutouts or perforations.

Do not use multiple-part forms.

Do not use paper that is heavily textured or embossed.

Tips for Selecting and Using Labels

The following Hewlett-Packard printers support labels:

HP DeskJet 510

HP DeskJet 520

HP DeskJet 540

HP DeskJet 550C

HP DeskJet 560C

HP DeskJet 600 Series

HP DeskJet 750C

HP DeskJet 800 Series

HP DeskWriter 510

HP DeskWriter 520

HP DeskWriter 540

HP DeskWriter 550C

HP DeskWriter 560C

HP DeskWriter 600 Series

While label support is not officially recognized in the User’s Guides, the
printers listed above can successfully be used if the following guidelines
are STRICTLY followed:



Caution Failure to follow the suggestions below can permanently
damage your printer.

The following are guidelines when using labels in HP DeskJet printers:

Use only Avery paper labels that are specifically designed for use
with HP inkjet printers.  These labels are less likely to peel when
inside the printer.

Do not use plastic or clear labels. DeskJet inks are formulated for
use with paper or specially treated plastic papers and will not dry
properly when used with plastic or clear labels.

Do not use ANY label material which is damaged, folded, curled,
or wrinkled in any fashion.  These conditions are frequent causes
of jams caused by labels peeling inside the printer. Labels that
have peeled inside the printer are difficult to remove and may
necessitate returning the printer to HP for service.

Do not use labels that are over two years old. Older label materials
are more likely to peel inside the printer.

Do not print on partially used sheets of label material. The varying
thicknesses of material passing over the print rollers can cause
label jams or print skew.

Observe the following guidelines when storing label materials:

Always store label materials in the manufacturer’s packaging until
ready for use. The manufacturer’s packaging protects the labels
and adhesives from humidity extremes which could prematurely
age the labels.

Always store label materials out of direct sunlight.

Keep label materials flat in the original packaging to help prevent
premature aging, wrinkling or bending.



Tips for Selecting and Using Banner Paper

For paper handling and printable area specifications, refer to
“Product Information/Specifications.”

Always use paper that conforms to the product’s specifications.
Refer to “Product Information/Specifications.”

Most 20 lb Z-fold banner-type paper will produce good results for
your banner printing needs.  However, HP Premium Inkjet Banner
Paper, will produce excellent printing results for all your banner
printing projects.

Before you purchase large quantities of a certain type of paper,
print a few sheets to determine if it provides acceptable quality
printing.

Be sure that your paper does not have tears, dust, wrinkles, or
curled or bent edges.



Tips for Selecting and Using HP Photo Paper with
the HP Photo Cartridge

Verify that the HP Photo Cartridge is intended for use in your
printer. Refer to the “User’s Guide” for your printer.

Remove the black print cartridge and replace it with the HP Photo
Cartridge. Refer to the “User’s Guide” for your printer for
instructions.

Be certain that you have selected “Use HP Photo Cartridge” in the
Page Setup box.

Use HP Photo Paper (loaded glossy-side down) in your printer’s
IN tray, not HP Premium InkJet paper when you print photographs.
Using HP Photo paper will ensure high-quality, fade-resistant
images.

For paper handling and printable area specifications, refer to the
“User’s Guide” for your printer.

Before you purchase large quantities of a certain type of paper,
print a few sheets to determine if the paper provides acceptable
quality printing.

Be sure that your paper does not have tears, dust, wrinkles, or is
curled, or has bent edges.

For best results with the HP Photo paper/HP Photo cartridge
combination, scan your photographs at 100 or 150 dpi.  If you scan
them at a higher dpi, you won’t improve the print quality, and your
photographs will take longer to print.

Printing in Best mode yields the most vivid colors. (If the slower
printing speed is acceptable.)



Loading Paper Tips

General Tips for Loading Media Effectively

To obtain the best print quality and avoid getting media jammed in
the paper feed rollers, always use paper and other media that
conform to the product’s specifications.  Refer to “Product
Information/Specifications.”

Load only one media type at a time into the IN tray making sure the
right edge of the media is aligned with the right edge of the IN tray.

Insert all paper, cards, envelopes, labels, transparencies and
banner paper print-side-down into the IN tray of the printer. (See
"Determining the Print Side of Media.”)

Never load more than the recommended amount of media into the
IN tray at one time.

Always load index cards, postcards, and envelopes in portrait
orientation (that is, where the paper is longer than wide when
placed in the IN tray).

Always use print settings in the printer driver that match the media
type, size, and orientation.

Before inserting a stack of media into the IN tray, always tap its
edges on a flat surface to even it out.



Determining the Print Side of Media

Insert all paper, cards, envelopes, labels, transparencies and banner
paper print-side down into the IN tray of the printer. Here are some tips for
loading media print side down:

For plain paper, load the side identified by the paper’s packaging
as the printside face down.

For letterhead paper, load the letterhead side down and facing the
back of the paper tray.

For HP Premium Inkjet Paper, load face down the side identified
on the packaging as the print side with the corner arrow facing the
back of the paper tray.

For HP Premium Glossy Paper, load the glossy side down.

For index cards or postcards, load the side designed to be written
upon face down.

For envelopes, load the side you address face down

For labels, load the paper side down (the slick side up).

For HP Premium Transparency Film, load the rough side down
with the sensing strip facing the back of the paper tray.

For HP Premium Banner Paper, load face down the side identified
on the packaging as the print side with the corner arrow facing the
back of the paper tray.

Using the Single-Sheet Feeder

If your printer is equipped with a single-sheet feeder, the single-sheet
feeder allows you to feed a single sheet of paper or other media into the
printer without unloading the IN tray. The single-sheet feeder slides freely
to the right and left to accommodate the width of the media you insert.
Always use paper and other media that conform to the product’s
Specifications.  Refer to “Product Information/Specifications.”



Part Numbers

Part Numbers and Other Information

Power Cord
Plug Type

Country or
 Region

Region’s
AC Voltage

HP Part
Number

    2121601

US, Canada, Mexico,
Korea, Taiwan,

Arabic Countries

Japan

120V

100 V

8120-6836

8120-6176

      2121602

Eastern and Western
Europe, Jordan,

Lebanon, North Africa,
Russia

220V 8120-6174

         2121603

UK 220V 8120-6173

2121604

Switzerland 220V 8120-6179

       2121605

South Africa
India

220V 8120-6180

       2121606

Australia
New Zealand

Mainland China
220V 8120-6175

   2121607

Denmark 220V 8120-6178
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Warranty Information

The warranty for HP DeskJet/DeskWriter printers varies depending upon
the product and the date and country of purchase.

For products returned under warranty, Hewlett-Packard may use one of
the following options:

Repair the product

Replace the product with a re-manufactured unit

Replace the product with a product of equal or greater functionality

Refund the purchase price

Hewlett-Packard Limited Warranty Statement

H P
Product

Duration of Limited Warranty (Unless
otherwise stated in the printer’s
documentation)

Software 90 days

Print Cartridges 90 days

Printer and Peripheral Hardware 1 Year

Extent of Limited Warranty

1. Hewlett-Packard (HP) warrants to the end user customer that HP
products will be free from defects in materials and workmanship, for
a specified time after the date of purchase by the customer. The
duration of this limited warranty is stated above. Certain additional
conditions and limitations of HP’s warranty are stated in the user’s
guide. Those conditions and limitations include:

a. For software products, the warranty applies only to the media
upon which the product is recorded; and

b. HP does not warrant the operation of any product to be
uninterrupted or error free.



H P  D e s k J e t  a n d  D e s k W r i t e r  P r i n t e r s W a r r a n t y  I n f o r m a t i o n 

2. HP’s limited warranty covers only those defects which arise as a
result of normal use of the product, and do not apply to any:
a. Improper or inadequate maintenance;
b. Software or interfacing not supplied by HP;
c. Unauthorized modification or misuse;
d. Operation outside the product’s environmental specifications,

including duty cycle abuse or use of a mechanical switchbox
without a designated surge protector;

e. Use of non-supported printing media or memory boards; or
f. Improper site preparation or maintenance.

3. For HP printer products, the use of a non-HP print cartridge or a
refilled print cartridge does not affect either the warranty to the
customer or any HP support contract with the customer; print
cartridge includes both toner cartridges and ink cartridges.
However, if printer failure or damage is attributable to the use of a
non-HP or refilled print cartridge, HP will charge its standard time
and materials charges to service the printer for the particular failure
or damage.

4. If any software media product or print cartridge product proves
defective during the applicable warranty period, and if the product is
covered by HP’s warranty, the customer shall return the product for
replacement.

5. If HP receives, during the applicable warranty period, notice of a
defect in a hardware product which is covered by HP’s warranty, HP
shall either repair or replace the product, at its option. Any
replacement product may be either new or like-new, provided that it
has functionality at least equal to that of the product being replaced.

6. If HP is unable to repair or replace, as applicable, a defective
product which is covered by HP’s warranty, HP shall within a
reasonable time after being notified of the defect, refund the
purchase price for the product, provided the customer returns the
product.

7. Your warranty is valid in any country where this product is
distributed by Hewlett-Packard. Contracts for additional services
such as on-site service are available from any authorized HP
service facility in countries where this product is distributed by HP or
an authorized importer.

8. This limited Warranty Statement gives the customer specific legal
rights. The customer may also have other legal rights which vary
from state to state in the United States, from province to province in
Canada, and from country to country elsewhere in the world.
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Limitations of Warranty

1. NEITHER HP NOR ANY OF ITS THIRD PARTY SUPPLIERS
MAKES ANY OTHER WARRANTY OF ANY KIND, WHETHER
EXPRESS OR IMPLIED, WITH RESPECT TO HP PRODUCTS. HP
AND ITS THIRD PARTY SUPPLIERS SPECIFICALLY DISCLAIM
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE.

2. To the extent that this Limited Warranty Statement is inconsistent
with the law of the locality where the customer uses the HP product,
this Limited Warranty Statement shall be deemed modified to be
consistent with such local law. Under such local law, certain
limitations of this Limited Warranty Statement may not apply to the
customer. For example, some states in the United States, as well as
some governments outside the United States (including provinces
in Canada), may:
a. Preclude the disclaimers and limitations in this Warranty

Statement from limiting the statutory rights of a customer (e.g.
Australia and the United Kingdom);

b. Otherwise restrict the ability of a manufacturer to make such
disclaimers or impose such limitations; or

c. Grant the customer additional warranty rights, specify the
duration of implied warranties which the manufacturer cannot
disclaim, or not allow limitations on how long an implied
warranty lasts.

3. To the extent allowed by local law, the remedies provided in this
Warranty Statement are the customer’s sole and exclusive
remedies.

Limitations of Liability

1. EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN
THIS WARRANTY STATEMENT, IN NO EVENT SHALL HP BE
LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES, WHETHER BASED ON
CONTRACT, TORT, OR ANY OTHER LEGAL THEORY AND
WHETHER ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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Obtaining Printer Drivers

Updates to the HP Printer Driver software occur periodically. New versions
can be obtained from authorized Hewlett-Packard dealers or any of the
sources listed below.

24-hour modem access

HP BBS Library

HP's electronic bulletin board library service is available 7 days a week,
24 hours a day for your convenient access to HP printer drivers and
support information.

In the United States (for the following baud rates: 300, 1200, 2400, 4800,
9600, 14400), call (208) 344-1691.

In the United Kingdom (for baud rates up to 14400) call,
44 (1344) 361891.

World-wide (for the following baud rates: 300, 1200, 2400, 4800, 9600,
14400), call 1 (208) 344-1691.

Set your modem communications software to N,8,1.

CompuServe

Printer drivers and interactive sharing of technical information are
available on CompuServe's HP Peripherals forum
(GO HPPER).

To subscribe in the United States, call CompuServe, Inc., at
(800) 524-3388 and ask for representative #51 (This service is not
operated by Hewlett-Packard).

To subscribe in the United Kingdom, call toll-free (0800) 289378 or
 (614) 529-1349.

To subscribe world-wide,  call (614) 529-1349.
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Internet

Printer drivers and product support information can be obtained through
the World-Wide Web as follows:
URL ttp://www.hp.com/home.html
or, www.hp.com/go/cposupport

Updated Printer Drivers by Mail

HP's Distribution Centers provide printer drivers and printer driver
updates.

Worldwide Fulfillment Information
Driver
Distribution

Languages
Available

Telephone
Orders

Fax
Orders

Mail
Orders

US and
Canada

English

French

Spanish

970-339-7009
Mon - Sat, 24 Hours
per day

970-330-
7655

US Driver
Fulfillment for
Hewlett-Packard
PO Box 1754
Greeley, CO  80623

UK

(0) is used
only when
calling within
the country

English   - - 44 (0) 1429 865 511

French  - - - 44 (0) 1429 863 343

German  - - 44 (0) 1429 863 353

Spanish  - - 44 (0) 1429 520 012

Italian   - - - 44 (0) 1429 520 013

Mon - Fri, 8:30 am to 6 pm CET,
(except Wed 8:30 am to 4 pm CET)

(Within UK)
0 1429 866
000

(Outside UK)
44 1429 866
000

European
Fulfillment for
Hewlett-Packard
c/o Starpack
International, Ltd.
PO Box 63
Hartlepool
Cleveland
TS25 2YP
United Kingdom

Asia Pacific
(Singapore)

All localized
languages

65 740 4477
Mon - Fri 8:30 am-
5:30 pm
Singapore time

65 740 4499
(24 hours a
day - 7 days
a week)

Fulfillment:
Plus Pte Ltd.
No. 51, Ubi Ave 3
Singapore 1440

Australia
(Sidney)

All localized
languages

612 565 6099
Mon - Fri 8:30 am-
5:30 pm Australian
Eastern Time

612 519
5631
(24 hours a
day - 7 days
a week)

Fulfillment:
Plus Pty Ltd.
Private Bag 75
Alexandria NSW
Australia 2015
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U.S. Service Support Contracts

HP Express Exchange Service

Hewlett-Packard offers an express exchange service to minimize product
downtime. With HP Express Exchange Service, a replacement unit is
available by 10:30 the next working day.

HP Express Exchange provides next day exchange service (same as HP
SupportPack) but the fee is based on a per incident of repair rather than
throughout the warranty period. This service does not need to be
purchased within 30 days of the printer purchase date.

To order the HP Express Exchange Service, call toll-free at 800-835-4747;
ask for ext. 524.

HP SupportPack

The HP SupportPack is an enhancement to the customer’s original one-
year warranty repair service.  The HP SupportPack provides next day
express exchange service (see above) for the duration of a three-year
warranty period. This service enhancement provides customers with a
cost-effective and timely way to achieve quality support.  The HP
SupportPack (ordered like any other HP product) is sold exclusively
through resellers and is not available directly from Hewlett-Packard.
Customers must purchase this service enhancement within 30 days of
purchasing the printer. The HP SupportPack is     not    transferable from one
piece of equipment  Additional information on HP SupportPack and the
prices for the service upgrade are available through HPNN and the In-
Touch newsletter.

HP Customer Return Repair Service

If uptime is less critical, the HP Customer Return Repair Service provides
maintenance service at the HP Customer Service Center located in
Corvallis, Oregon. HP will repair the product within two working days from
receipt and return via surface transportation.

To order the HP Customer Return Repair Service for customers with non-
critical applications, call toll-free 800-835-4747; ask for ext. 524.
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Non-U.S. Service Support Contracts

HP SupportPack

The HP SupportPack enhances the service offering during the warranty
period by upgrading warranty repair service to a next day exchange
service. This service enhancement provides customers with a cost-
effective and timely way to achieve quality support. HP SupportPack is
sold exclusively through resellers (ordered like any other HP product) and
is not available directly from Hewlett-Packard. Additional information on
HP SupportPack and the prices for the service upgrade is available
through HPNN.

For other service and support contracts, contact the Hewlett-Packard office
or Response Center for that country.
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Returning a Printer for Service

In the USA

If a printer requires service, the customer can contact a service authorized
reseller. The reseller should verify that the printer is in need of repair and
contact the HP Corvallis Service Center. Sales authorized resellers
should call (800) 544-9976 to arrange for repair. Service authorized
resellers should call (503) 750-2035.

Customers can contact Hewlett-Packard directly by calling HP Customer
Support Center at (208) 323-2551. They will verify that the printer is in
need of repair and transfer the customer to the HP-Corvallis Repair
Center. If packaging materials are needed, call the HP Resellers
Response Line at (800) 544-9976.
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Printer Return Instructions

If the printer needs to be shipped, be sure it is packed in a protective
carton. Hewlett-Packard recommends that the original shipping container
be saved for this purpose. In-transit damage is not covered by the
warranty. It is suggested that shipments are always insured.

When either a customer or reseller calls HP to arrange for service, the HP
Corvallis Service Center will dispatch a premium carrier to pick up the
product at the reseller or customer location. The printer will be delivered to
HP, at HP’s expense, using second day delivery. The customer or reseller
must still package the printer for shipment.

Once the printer is repaired, HP will ship it to the customer or reseller
location using second day delivery.

You can help assure effective servicing of your customer's printer by
following these guidelines:

Procedure:

1. Follow the troubleshooting instructions in this manual to make
certain the malfunction is in the printer and not the result of an
interface error or a malfunction in the computer or software. If
possible, identify the defective area or function.

2. If you determine that repair is required, please provide the following
with the printer when returning the printer for service:

a. Printout a copy of the “HP Printer Repair Sheet.”  (For
information regarding printouts, see the note at the top of the
HP Printer Repair Sheet.)

b. Determine the appropriate customer code from the Printer
Repair Feedback Information section which follows.

c. Fill out the repair sheet. Include specific information, such as
the configuration at the time of the malfunction, the type of
interface cable, a description of the computer or host, and a
description of the software application in use.

d. If purchased through a Hewlett-Packard reseller, include a
copy of the sales slip or other proof of purchase to establish
the warranty coverage period.
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In the UK, France, Germany, Switzerland, Austria,
Belgium, Norway, Sweden, Denmark, Finland, and
the Netherlands

If a printer fails during the warranty period, the customer should do the
following:

1. Follow the troubleshooting procedures in this document or consult
the HP FIRST facsimile assistance services.

2. If the customer is still unable to determine the cause of the failure,
the customer should contact their local reseller or the European
Customer Support Center.

Customer support representatives can answer your questions
regarding the setup, configuration, installation, and operation of the
printer. They can also troubleshoot and diagnose printer problems
and, if necessary, can give instructions for getting the printer
serviced and repaired.

If available for your country and language, phone numbers for HP
FIRST and the European Customer Support Center are given in a
separate document shipped with the printer. If additional
information is needed, customers can call the reseller or the nearest
HP Sales and Support Office.

If a printer fails after the warranty period:

1. Follow the troubleshooting procedures in this document or the
printer user's guide.

2. If the customer is unable to determine the cause of the failure, the
customer should contact their local reseller or the nearest HP Sales
and Support Office for instructions on returning your printer for
service and repair.
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Elsewhere in the World

If a printer fails during or after the warranty period:

1. Follow the troubleshooting procedures in this document or the
printer user's guide.

2. If the customer is unable to determine the cause of the failure, the
customer should contact their local reseller or the nearest HP Sales
and Support Office for instructions on returning your printer for
service and repair.

Notes     Operating accessories (such as, optional plug-in
cartridges, print cartridges, and software) should not
be included with the printer unless the problem
relates to an accessory.

    In the U.S., the power module should not be included
with the printer unless instructed otherwise.

    Outside of the U.S., the power module should be
included when returning the printer for repair.
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Service and Support Resources

HP Support Assistant (CD-ROM)

HP Support Assistant is an on-line tool providing technical information on
a variety of Hewlett-Packard computers and peripheral products. This
information is contained on a CD-ROM which is updated quarterly and
mailed to you as part of the subscription. This system runs on any PC
under MS Windows.

Obtaining HP Support Assistant CD-ROM

Country
Telephone
Number

Fax
Number

Mailing
Address

U.S., Canada 1 (800) 457-
1762

(24 Hours)
7 Days)

(317) 364-8888 Hewlett-Packard Company
PO Box 4700
Crawfordsville, IN 47933
USA

Latin America 01 (317) 364-
8882

(24 Hours)
(7 Days)

(317) 364-8888 Hewlett-Packard Company
PO Box 4700
Crawfordsville, IN 47933
USA

UK 1 (800) 457-
1762

(24 Hours)
(7 Days)

0-800-960-273 Hewlett-Packard Company
PO Box 501
7300 AM Apeldoorn
The Netherlands

Europe 31 (55) 384279
(9:00 - 6:00)
(Monday -

Friday)

31 (55) 434455 Hewlett-Packard Company
PO Box 501
7300 AM Apeldoorn
The Netherlands

Asia Pacific 65 740-4629
65 740-4477
(8:30 - 5:30)
(Monday -

Friday)

65 740-4617
65 740-4477

Hewlett-Packard Company
Circuit Road PO Box 0131
Singapore 9137
Singapore

Hewlett-Packard News Network (HPNN)

HPNN is an electronic bulletin board service available only to HP
authorized resellers. This service provides the following information:

Presales Information

Printer Drivers

HP SupportPack Information

Software Notes

Postsales Information
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For more information, call 1 (408) 553-7303.

HP Distribution Center

The HP Distribution Center has current printer drivers for Hewlett-Packard
products. Call 1 (303) 339-7009 except Sundays.

HP Customer Information Center

The HP Customer Information Center provides presales product
information. This service is available for resellers and end-user customers.
Call 1 (800) 752-0900, Monday - Friday, 6:00 AM - 5:00 PM Pacific Time.

HP Reseller Response Line

The HP Reseller Response Line provides pre-sales and post-sales
technical support for HP authorized resellers. Call 1 (800) 544-9976,
Monday - Friday, 8:00 AM - 4:00 PM Pacific Time.



H P  D e s k J e t  a n d  D e s k W r i t e r  P r i n t e r s S e r v i c e  a n d  S u p p o r t  R e s o u r c e s 

Ordering Supplies

Ordering Supplies
Country Telephone Number

Austria (1) 25000 536

Australia/New Zealand (03) 895-2895

Belgium/Luxembourg 02-778 34 00

Canada (Except Toronto) 1 (800) 387-3154

Canada (Toronto) (416) 671-8383

Community of Independent Sales (095) 181 8002

Czech Republic (2) 47 17 230

Denmark 4599 1000

Europe (East Central Headquarters) (1) 25 000 0

Finland (90) 887 21

France Minitel 3616 HPMICRO,
Rubrique 2: “Points de Vente” agréés

Germany 0180-53262-22

Greece 30-1-689 64 11

Hungary (1) 142 09 86

Iceland (1) 67 10 00

Israel 00972 3 53 80 380

Italy 02/9212 4378

Japan (03) 331-6111

Latin America (525) 326-40-00

Lebanon 009611 89 31 13

Norway 22 73 56 00

Poland (22) 37 50 65

Portugal (01) 301 7343

Slovenia (61) 159 33 22

South Africa 002711 806 10 00

Spain 900 123 123

Sweden (0) 8 750 2000

Switzerland 01 / 735 71 11

The Netherlands 020 - 547 6666

Tunisia 002161 28 01 44

Turkey (0) 212 224 59 25

United Arabian Emirates 009714 37 75 91

United Kingdom 01344 369 369

U.S. 1 (800) 538-8787
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HP BBS Library

The HP electronic bulletin board library service contains drivers and
support information which can be downloaded to your PC via modem.

HP BBS Library
Country Number Baud Rate

Austria + 43 (222) 251658 2400, 4800, 9600, 14400,
19200, 28000, or ISDN

Belgium + 32 (2) 778-3819 1200, 2400, 4800, 9600,
14400

Denmark + 45 (45) 991905 300, 1200, 2400, 4800, 9600,
14400

Finland (9600) 7280 2400, 4800, 9600, 14400

France 3616 HP MICRO 1200 to 14400 (Service
Minitel)

Germany *HP# Datex J-BTX System

Italy + 39 (2) 9210-4244 Up to 14400

Netherlands + 31 (20) 647-5433 2400, 9600, 14400

Norway + 47 (2) 273-5697 2400, 4800, 9600, 14400,
19200

Sweden + 46 (8) 750-6262 2400, 4800, 9600, 14400

Switzerland + 41 (64) 560200 Up to 19200 or ISDN

United Kingdom + 44 (1344) 361891 Up to 14400

United States + 1 (208) 344-1691 300, 1200, 2400, 4800, 9600,
14400

Worldwide Int Code + 1 (208) 344-1691 300, 1200, 2400, 4800, 9600,
14400

Set your modem for no parity, 8 data bits, and 1 stop bit (N, 8, 1).
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HP FAXback on Demand - HP FIRST

You can use this service to select documents, such as product
descriptions and technical information, which are then faxed to you. To
access this service, use the handset on your fax machine and dial the
appropriate number from the table in this section.

Use the following steps to use HP FIRST:

1. Call the system. You will need to use a touch-tone telephone or
the phone set of your fax machine. A voice prompt will welcome
you and guide you to the information you need. You will also need
to give the phone number of the fax machine where you wish to
receive the documents you select.

2. We suggest you initially request the index which lists all available
documents.

3. Once you receive the HP FIRST index, choose the documents you
need.

4. Call HP FIRST again. A voice prompt will ask you for the index
number of the documents you have selected and would like to
have faxed to you.

5. Selected documents will be sent immediately to the fax number
you have specified.

Note To obtain documents in English from outside the UK, dial
your international access code and then (31) 20 681 5792
(international toll rates applicable).
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HP FIRST Telephone Numbers
Country (Language) Telephone Number

Austria (German) 0660-8128

Australia (English) 61-3-272 26 27

Denmark (Danish) 800-10453

Belgium (French) 0800 1 7043

Belgium (Dutch) 0800 1 1906

Europe (English) (31) 20 681 5792

Finland (Finnish) 9800-13134

France (French) 05-905900

Germany (German) 0130-810061

Hong Kong (English) 506 24 22

Italy (Italian) 1678-59020

Korea (Korean) 82-2-769 05 43

Netherlands (Dutch) 06-0222420

Norway (Norwegian) 800-11319

Singapore (English) 65-291 79 51

Spain (Spanish) 900-993123

Sweden (Swedish) 020-795743

Switzerland (French) 155-1526

Switzerland (German) 155-1527

UK 0800 96 02 71

US 1 (800) 333-1917

Worldwide Int Code + 1 (208) 344-4809

HP Audio Tips (U.S. Only)

HP Audio Tips is an automated audio (voice) problem-solving tips for your
most frequently asked questions. Use the following telephone number:

1 (800) 333-1917
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HP Forum on CompuServe

The HP Systems Forum on CompuServe is an on-line service accessible
via modem. This service provides information about Hewlett-Packard
products, and allows you to communicate with other Hewlett-Packard
users.

You can join CompuServe at no charge by calling a telephone number in
the table below. CompuServe will send you a free introductory
membership immediately, including information on how to access
CompuServe.  From the CompuServe prompt, type:

GO HP  <Enter>
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CompuServe Telephone Numbers by Country Table
Local Call/

Country Free-Phone Number Direct Number

Argentina 54 (1) 345-3871

Australia (008) 025240 61 (2) 410-4260

Canada 1 (800) 848-8199 1 (614) 529-1349

Chile 56 (2) 696-8807

France 36,638,122 33 (1) 4714-2160

Germany (0130) 3732 49 (89) 6655-0111

Hong Kong 852 867-0118

Hungary 36 (1) 156-5366

Israel 972 (3) 290466

Japan (0120) 221200 81 (3) 5471-5806

New Zealand (0800) 446113 61 (2) 410-4260

Portugal 33 (1) 4714-2160

South Africa 27 (12) 841-2530

South Korea (080) 022-7400 82 (2) 411-1327

Spain 33 (1) 4714-2160

Taiwan 866 (2) 651-6899

UK (0800) 289378 44 (1272) 760680

U.S. 1 (800) 848-8199 1 (614) 529-1349

Venezuela 58 (2) 793-2984

Worldwide Int Code + 1 (614) 529-1349
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Hewlett-Packard Telephone Support

Technical Phone Support for Customers

The HP Customer Support Center provides free live technical assistance
for peripherals during the hardware warranty of the product. If the product
is still under warranty, the customer should call (208) 323-2551. If the
product is out of warranty, the customer has two options.

The customer can call 1 (900) 555-1500 at $2.50 per minute.

The customer can call 1 (800) 999-1148 at $25.00 per call using
VISA or MasterCard.

(The above prices are subject to change without notice)

To ensure the call is dealt with quickly, have the following information
ready:

The product model number and serial number.

The operating system version and the configuration.

A description of the software installed and the accessories used.

HP North American Customer Support Center

Assistance from the Hewlett-Packard North American Customer Support
Center is available Monday to Friday, 7:00 AM to 6:00 PM Mountain time,
except Wednesday when the hours are 7:00 AM to 4:00 PM.

1 (303) 635-1000

HP European Customer Support Center

Assistance from the Hewlett-Packard European Customer Support Center
is available in English, Monday to Friday, 8:30 AM to 6:00 PM Central
European time, except Wednesday when the hours are 8:30 AM to 4:00
PM.

Int Code + 31  (20) 682-8291
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Contacting Hewlett-Packard

To contact Hewlett-Packard, check your local telephone directory for the
HP Sales and Service Office near you. If you cannot find an HP office,
contact one of the major HP Sales and Service Offices or one of the
following Worldwide Marketing Headquarters.

Asia
Far East Sales Region Headquarters
Hewlett-Packard Asia Ltd.
22/F Peregrine Tower
Lipp Centre
89 Queensway, Central
Hong Kong

Canada
Hewlett-Packard Ltd.
6877 Goreway Drive
Mississauga
Ontario L4V 1M8, Canada

Europe
European Operations Headquarters
Hewlett-Packard S.A.
150, route du Nant-d’Avril
PO Box 1217
Meyrin 2/Geneva, Switzerland

Latin America
Hewlett-Packard Latin Am. Headquarters
Monte Pelvoux 111
Lomas de Chapultepec
11000 Mexico D.F.

Middle East/Africa
Middle East/Central Africa Sales Headquarters
Hewlett-Packard S.A.
Rue de Veyrot 39
CH-1217 Meyrin 1/Geneva, Switzerland

U.S.
Intercon Operations Headquarters
Hewlett-Packard Company
3495 Deer Creek Road
PO Box 10495
Palo Alto, CA 94303-0896, USA



H P  D e s k J e t  a n d  D e s k W r i t e r  P r i n t e r s P r i n t e r  R e p a i r  F e e d b a c k  I n f o r m a t i o n 

Printer Repair Feedback Information

Procedure for Providing Repair Feedback Information:
1. Make a copy of the HP DeskJet Printer Family Repair Sheet found

on the following page.

2. Observe the problem with the printer. Verify the problem is
repeatable.

3. Determine the customer code from the table below.

4. Fill out the repair sheet and return the repair sheet with the printer.

HP DeskJet Printer Family Customer Codes
Customer
Code

Failure
Keywords

Failure
Description

STARTUP
PROBLEMS

CPS100 Power-Up Failed No lights, no noise, no movement, power failure,
dead

CPS105 Self-Test Failed Self-test does not print or is incomplete/wrong

CPS110 Erratic/Intermittent
Operation

Product behaves inconsistently or exhibits an
intermittent failure

CPS200 Lights On Steady LEDs on front panel ON steady

CPS205 Lights Flash in Unison LEDs on front panel ON and flashing

CPS210 No Lights/Fan Only/No
Lamp

No LEDs On or no LEDs and the fan is ON or lamp not
on

CPS215 Lights Flashing
Alternately

Different LED’s flash On and Off alternately

QUALITY

CWP000 Multiple Exchange Customer has received more than one exchange per
incident

CWP005 Customer Return Customer returns exchanged unit

CWP010 Re-Repair 90 days Unit fails within 90 days of previous repair

CWP015 Defective from Stock Unit shipped to customer is defective from stock

CWP020 Customer Damaged Customer/Reseller has damaged or mis-repaired unit

CWP025 Wrong Model Wrong model or product sent to customer

PERFORMANCE

CPG100 Won’t Print Printer will not print or locks up while printing

CPG105 Stops Printing Prints part of a page then stops

CPP100 Burning Smell During operation, unit emits a burning smell

CPN100 Grinding, Squeaking,
Scraping Noise

Unusual, persistent grinding, squeaking, scraping
noise

CPN105 Knocking, Clicking,
Chattering Noise

Frequent shock or clicking or chattering noise

Table continued on next page
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HP DeskJet Printer Family Customer Codes (Cont.)
Customer
Code

Failure
Keywords

Failure
Description

MEDIA HANDLING

CMM100 No Media Pick-Up Paper/envelope/transparency not loading

CMM105 Multiple Pick Several sheets/envelopes are picked together

CMM110 Incomplete Load Sheet/envelope loads then stops or media slips

CMM115 Media Jams Sheet/envelope/labels stuck inside of
product/obstruction

CMM120 Skewed/Slanted Page Sheet/envelope loads unevenly

CMM135 Media Eject Problem Sheet/envelope fails to eject

CMM140 Continuous Media
Feed

Continuously picks and feeds media

CMM150 Tracks on Media Excessive force on pinch wheels causes tracks on
media

PRINT/ IMAGE
QUALITY

CGT100 Missing Dots White line or streak through text or graphics, partial
characters

CGT105 Fuzzy/Blurred/Wavy or
Unusual Print

Overspray of dots or print appears wavy or
compressed or faded

CGT110 Vertical Misalignment Table columns of text/vertical lines are not well
aligned (bi-directional shift)

CGT115 Underlines or Streaks
in Printing

Prints extra lines across media when printing self-test

CGT120 Incomplete/Faded
Print

Parts of printed characters are missing on self-test or
print is faded

CGT125 Won’t Print Carriage moving but not printing

CGT130 Wrong Colors Printing wrong colors or ink appears mixed

CPG115 Hardware Banding Printed page exhibits banding in print not caused by
the print cartridge

Table continued on next page
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HP DeskJet Printer Family Customer Codes (Cont.)
Customer
Code

Failure
Keywords

Failure
Description

CARRIAGE
PROBLEMS

CCP100 Left-Side Collision Carriage slams to left side and stays there

CCP105 Right-Side Collision Carriage slams to right side and stays there

CCP120 Erratic/Slow Movement Erratic, slow movement or carriage stalls or hangs

CCP125 Pen Won’t Lock Pen cartridge won’t lock in carriage

COMMUNICATION

CKK100 I/O Port Fail Serial or parallel Input/Output from PC fails to
print...not cable or PC

CKK105 LAN/MIO Fail Local Area Network communications failed

PRINT
CARTRIDGE (PEN)

CTT105 Leaking Pen Print cartridge has leaked in printer and damaged
printer

CTT110 Rejects Cartridge Printer rejects cartridge or cartridge will not install
properly

CTT120 Short Pen Life Cartridge life not to specifications

MISCELLANEOUS

CYD100 Loose/Damaged part Broken, scratched, damaged or loose part

CZZ000 NTF No trouble found
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HP Printer Repair Sheet

Note To print this form, select “Print” under the “File” menu.

Company Information
Company name: __________________________________________
Address: ________________________________________________
________________________________________________________
Phone number:____________________________________________
Your name: ______________________________________________

Printer Information
Printer model: ____________________________________________
Serial number: ____________________________________________
Date of purchase: __________________________________________
Date that you are sending the printer: ___________________________
Customer code: ___________________________________________
Failure is:

Occasionally intermittent: ___
Frequently intermittent: ___

Continuous: ___

Brand and model of your computer: ____________________________
Version of software you are using: _____________________________
The driver you are using: ____________________________________
Other information about the problem: ___________________________
________________________________________________________

Included Information
Check the following if able to provide additional troubleshooting
information.
___Sample printout included
___Printer self-test included
___Unable to print the printer self-test
___Actions taken to resolve the problem and the results
________________________________________________________
________________________________________________________
________________________________________________________



MS Windows Printing

The HP ColorSmart printer driver supports MS Windows 3.x and MS
Windows 95. Access to the HP ColorSmart printer driver to change
specific settings is available from within your software application
programs. The steps to access the printer driver vary depending upon the
application software program. Generally, the printer driver is found under
“File” in the “Print” menu.

Note Although MS Windows come with printer drivers that work
with HP DeskJet printers, the drivers do not provide access to
some of the more advanced capabilities of HP DeskJet
850C/855C series printers. Only the HP ColorSmart printer
driver takes full advantage of all features.

Access to select the printer driver is through MS Windows’ “Printers”
control panel. The Printers control panel allows you to:

Select the default printer from a list of loaded printer drivers.

Add Microsoft printer drivers.

Remove unneeded printer drivers.

Set various printer options (which may be superseded by the
printer settings selected in the software application program).

Confirm the port which the printer is using.

To open the Printers control panel:
1. Double-click Main in the Program Manager.

2. Double-click Control Panel.

3. Double-click Printers.

The default printer is listed in the text box at the top of the dialog box. To
select a different default printer, double-click a printer from the list of
installed printers.

Although the Printers control panel provides access to various printer
settings, like paper type and page orientation, these settings are
overridden by settings made from within an application. The Printers
control panel settings are used when an application does not specify
certain defaults.



Because you can connect your printer to either an LPT or a COM port, it is
important to make sure the proper port is selected before printing. The
steps below describe how to select or change a printer port from the
Printers control panel.

To select a port:
1. Open the Printers control panel.

2. Click Connect.

3. Select the port from the list.

The default printer’s name is followed by the name of the port to which it is
is connected.



HP Printing System for Windows

The HP Printing System for Windows includes:

HP ColorSmart Printer Driver

HP DeskJet Status Monitor

HP DeskJet Utilities program group

14 TrueType Fonts

Quick Tour (available during installation only)

HP Control Panel for DOS

The HP DeskJet Status Monitor allows you to:

Monitor a current print job

Monitor the printer’s status at any time

Print a self-test page

Clean the print cartridges

Align the print cartridges

Cancel the current print job

The HP DeskJet Status Monitor Dialog Box



The DeskJet Utilities include:

Online information about the HP DeskJet 850C/855C series
printers. To access the online information: click Help in the
ColorSmart dialog box or the ColorSmart Options dialog box, or
double-click the HP DeskJet 850C/855C Printer Information icon in
the HP DeskJet Utilities program group in the Program Manager.

Dr. DeskJet diagnostic program (HP DeskJet 850C only), which
contains detailed information about common printing problems
and  easy to understand solutions. To access Dr. DeskJet: click
Dr.DeskJet in the Online Information, or double-click the Dr.
DeskJet icon in the HP DeskJet Utilities program group in the
Program Manager.

Late-breaking release notes in the ReadMe.txt file.



Installing the Printer Driver

The minimum system requirements to run the HP Printing System for
Windows are:

Windows version 3.1

An 80386 processor

2 MB of RAM to print in black or 4 MB of RAM to print in color

10 MB free hard disk space

Before you install the printer software:
1. Unpack the printer and set it up with the procedures described in

“User Documentation/Setup Guide.”

2. Make sure the computer and the printer are both turned on and
connected with the proper cable.

3. Close any screen savers or other software running in the
background on your computer.

To install the HP Printing System for Windows
1. Insert Installation Disk 1 into the computer’s disk drive.

2. Click File in the menu bar of the Program Manager window.

3. Choose Run in the File menu to open the Run dialog box.

4. Type A:\SETUP or B:\SETUP (depending on the computer’s
configuration) in the text box and click OK.

5. Follow the on-screen instructions during the installation process
and provide appropriate computer system information.

6. Restart Windows to activate the HP DeskJet 850C/855C printer
driver.



After installing the software, the print cartridges need to be aligned before
beginning any print jobs.

To align the print cartridges:
1. Double-click the HP DeskJet Status Monitor icon in the HP

DeskJet Utilities program group.

2. Click Maintenance on the Status Monitor menu bar.

3. Choose Align Print Cartridges and follow the on-screen
instructions.



About the Printer Driver

The HP ColorSmart Printer driver software provides access to all the
capabilities of HP DeskJet 850C/855C series printers when used with
Windows applications. The following options are available from the
ColorSmart dialog box:

Automatic or Manual printing

Color or Grayscale printing

Best, Normal, or EconoFast print quality

Paper Type

Paper Size

Number of Copies

Ordered printing

Portrait or Landscape print orientation

The HP ColorSmart Printer Driver has built-in, context-sensitive help.
When an option in the dialog box is clicked, an explanation of that option
appears at the bottom of the dialog box. For more detailed help, click the
Help button in the ColorSmart dialog box.



Using the Printer Driver

To use the ColorSmart Printer Driver with the HP DeskJet 850C/855C
series printers from within a Windows application:

1. Choose Print (or Print Setup, depending on the application)
from the File menu.

2. Click the Setup button.

To use the ColorSmart printer driver with the HP DeskJet 850C/855C
series printer from the Windows Control Panel:

1. Double-click Main in the Program Manager window.

2. Double-click Control Panel.

3. Double-click Printers.

4. Select the HP DeskJet 850C/855C series printer in the
Installed Printers list and click the Setup button.

The ColorSmart Dialog box appears.

ColorSmart Printer Driver Dialog Box



HP DeskJet 850C/855C ColorSmart Dialog Box Options
Option Description

ColorSmart Automatic or Manual screen-to-printer color mapping.

Options Opens the ColorSmart Options dialog box.

Orientation Portrait (tall) or landscape (wide).

Print Quality Best (presentation quality), Normal (letter quality), or
EconoFast (draft quality).

Copies Set the number of copies to be printed. Click the Ordered
Printing box to collate the printed pages of multiple copies.

Paper Type The media may be either plain paper, one of HP’s special media
types, or transparency film.

Paper Size The pop-up menu displays selections supported by the printer.
Click the Custom button to specify a custom paper size.

OK Accept changes.

Cancel Cancel changes.

Default Save the current settings as the default settings for the
ColorSmart Dialog Box.

Help Opens the online help.

ColorSmart: Automatic vs. Manual Printing

In most cases the best print output is obtained by choosing Automatic
ColorSmart printing. In automatic mode, the printer driver uses HP’s
ColorSmart technology to intelligently analyze each element in a
document at the time of printing to provide the best color output.

If the color output obtained using the Automatic ColorSmart option is not
satisfactory, use the Manual option.



To print in Manual ColorSmart mode:
1. Select the Manual button.

2. Click the Options button, which opens the ColorSmart Options
dialog box.

The Manual ColorSmart Options dialog box  provides control over
Intensity, Halftoning, and Color Control.

The Intensity slider bar adjusts the amount of ink applied to the paper—
Darker means more ink, Lighter means less ink. Halftoning describes how
the driver places individual drops of ink on the page to reproduce different
shades of the same color. Scatter halftoning, the default setting, usually
gives the best results. Pattern halftoning applies different patterns of dots
for different shades of a color.

The Color Control offers two options: Vivid Color and Match Screen. To
print the document so it looks like it looks on the computer screen, choose
Match Screen. To make the colors of the printed output brighter and more
vivid than they appear on the screen, choose Vivid Color.

Manual ColorSmart Options Dialog Box



Grayscale Printing

To economize on the use of the color print cartridge, print draft copies of
color documents in grayscale. Grayscale printing is significantly faster than
color printing, and it gives a good approximation of the final output. To
print in grayscale, select the Print in Grayscale option in the
ColorSmart dialog box.

The Grayscale Option dialog box provides control over intensity and
halftoning.

Grayscale Options Dialog Box



Optimizing Performance

The print speed and overall performance of HP DeskJet 850C/855C series
printers can be affected by several things:

The amount of RAM can determine how fast documents are sent to
the printer. Increasing RAM can speed up this process as well as
make the computer work more efficiently at other things besides
printing.

The printer driver used to print documents can make a significant
difference in the quality of the printed output. Make sure an up-to-
date version of an HP printer driver designed specifically for the
HP DeskJet 850C/855C series printer is installed. To check this:

1. Double-click the Printers icon in the Windows Control Panel.

2. Select the HP DeskJet 850C/855C series printer in the
Installed Printers list.

3. Click Setup to check the version number. The version number
is located in the title bar of the HP ColorSmart dialog box.

The size and complexity of the documents printed can make a
difference in the printer's performance. Graphics are usually more
complex - especially color graphics - and print more slowly than
text.

The processing speed of the computer will determine how fast a
document is sent to the printer. For example, a computer with a
486 processor runs faster than a computer with a 386 or a 286
processor.

Running numerous software programs at one time slows down
printing; each open program uses RAM. Therefore, limit the
number of programs or documents open at one time.

Screen fonts are stored in RAM, which means they use up memory
that the printer may need in order to print. Delete screen fonts or
printer fonts that are not needed.



Using Online Help

Two types of online help provide information about the printer software.

Printer Software Help

Type of help Provides How to access/where to find

Context Sensitive
Help

Information about
options in the dialog box
when you click on certain
parts of the screen.

Available within the ColorSmart Printer
Driver dialog box.

Online Help Comprehensive
information about the
printer software and
hardware.

Click the Help button within the
ColorSmart Printer Driver dialog box.

ReadMe Files Release notes and
current information.

On the Driver Installation Disk.

Cleaning and Aligning Print Cartridges

All of these functions are available from within the HP DeskJet Status
Monitor. For more information on printer cartridge services, refer to “Print
Cartridge Information.”



DOS Printing

Printer Drivers Available

Since DOS applications are developed independently under different
standards, each DOS application requires its own printer driver. Current
software drivers for most HP DeskJet printers are available from the
individual software manufacturers. A list of DOS software manufacturers is
in the DOS Printing Guide, part of the User’s Guide Kit. Information on
installing a DOS printer driver for a particular DOS application is supplied
by the software manufacturer.

If there is no driver available for your DeskJet 850C/855C series printer,
use a driver for a different HP DeskJet printer. In some cases, the
substitute driver will not provide access to all of the DeskJet 850C/855C
series printer’s capabilities. The following table outlines usable drivers
and their capabilities when used with DeskJet 850C/855C series printers.

Substituting Printer Drivers

Printer Driver Supported Features

HP DeskJet 855C Color Printing

HP DeskJet 660C Color Printing

HP DeskJet 560C Color Printing

HP DeskJet 540 Color Printing

HP DeskJet 500C Color Printing

HP DeskJet 320 Color Printing

HP DeskJet 310 Color Printing

HP DeskJet 520 Monochrome Printing Only

HP DeskJet 510 Monochrome Printing Only

HP DeskJet 500 Monochrome Printing Only

HP DeskJet PLUS Monochrome Printing Only

HP DeskJet Monochrome Printing Only



DeskJet Control Panel for DOS

The HP DeskJet Control Panel for DOS is software that replaces the front
panel switches found on older printers. The Control Panel for DOS does
not replace printer drivers; it must be used along with DOS software printer
drivers. When there is no specific DeskJet 850C/855C series printer driver
available for an application, the HP Control Panel for DOS gives the user
access to print settings and features not available through the DOS
application. If settings are available in the DOS application printer driver
and the DOS Control Panel, the settings made in the DOS application
usually override those made in the HP Control Panel for DOS.

The HP Control Panel for DOS lets the user monitor the printer’s status,
and clean and align the print cartridges.

Minimum System Requirements

DOS version 3.3 (or newer)

An 80286 (or better) processor

2 MB of RAM to print in black or 4 MB of RAM to print in color

Installation

Before you install the HP Control Panel for DOS:
1. Unpack the printer and set it up.

2. Make sure the computer and the printer are both turned on and
connected with the proper cable.

To install the Control Panel for DOS:
1. Insert the disk containing the control panel software into the disk

drive.

2. At the DOS prompt, type A:\Install (or B:\Install depending on
the floppy drive configuration) and press Enter.

3. Follow the on-screen instructions.

After installing the software, the print cartridges need to be aligned before
beginning any print jobs.



To align the print cartridges:
1. Type DJCP at the DOS prompt to open the stand-alone DOS

Control Panel.

2. Select Align Print Cartridges and follow the on-screen instructions.

Two Ways to Use the HP Control Panel for DOS

The DOS Control Panel can run either as a stand-alone application or as
a memory resident application. To run the DOS Control Panel as a stand-
alone application: type DJCP at the DOS prompt.

The DOS Control Panel must be loaded into memory at start-up to work as
a memory resident application.

To set up the HP Control Panel for DOS as a memory resident
application:

1. Type DJCP at the DOS prompt to open the stand-alone DOS
Control Panel.

2. Select More Settings.

3. Select Memory Resident Functions.

4. Select Make Memory Resident.

5. Select Done and reboot the computer.

To open the memory resident DOS Control Panel: type the DOS Control
Panel hot key.

T h e  m e m o r y  r e s i d e n t  D O S  C o n t r o l  P a n e l  i s  a  s u b s e t  o f  t h e  s t a n d - a l o n e 
application due to memory considerations.



Memory Resident DOS Control Panel

Whether stand-alone or memory resident, the DOS Control Panel allows
the user to control or view the following:

Pen Services (clean, prime, and align the pens)

Print Quality

Page Orientation

Font Width (normal or compressed)

Status Reports (limited in the resident Control Panel for DOS)

Context-Sensitive Help

In addition to these, the stand-alone DOS Control Panel provides
access to:

Paper Size

Media Type (paper or transparencies)

Character Set

Lines per Page

Line Termination

Reset All Settings

Memory Resident Controls



Troubleshooting

Problems with the DOS Control Panel

Problem Cause Solution

Installation was
unsuccessful

Disk error Reinstall Control Panel

Bad floppy disk Contact authorized HP dealer



OS/2

The HP ColorSmart printer driver for the HP DeskJet 540 printer can be
accessed through OS/2 by using Windows 3.1 in OS/2.



Macintosh Printing

The printer driver software enables your computer to communicate with
your printer. The Hewlett-Packard printer software is easy to install and
features:

Printer drivers for Macintosh’s QuickDraw and QuickDraw GX
environments.

27 TrueType fonts, plus compatibility with PostScript fonts.

Deciding Which Printer Driver to Install

Before using the printer you must install the printer driver software
appropriate for your computer. The printer driver software works with
Apple’s QuickDraw or QuickDraw GX.

To check if QuickDraw GX is installed in your system:
1. Open the System Folder.

2. Open the Extensions Folder.

3. Look for the QuickDraw GX icon (no icon appears for QuickDraw).

QuickDraw GX is only available on system 7.5 or greater. To identify your
system software, select About This Macintosh in the Apple menu.

QuickDraw GX Driver Special Features

QuickDraw GX is an extension to QuickDraw, and provides:

Background or foreground printing.

Desktop printer icons.

Drag and drop printing.

Printing status messages, allowing you to view the jobs in the
queue; stop, pause, or remove jobs; change the printing order of
the queued jobs.

Added options to the Print and Page Setup dialog boxes allowing
print quality control.



Hewlett-Packard recommends installing the printer driver software for
QuickDraw GX if your system supports it. However, you decide whether to
install the QuickDraw or the QuickDraw GX printer driver.

Font Information

The printer driver software includes two disks containing fonts and a font
installer.

1. The HP Fonts Install Disk

2. The HP Series Fonts Disk

Available Fonts

The HP 27 TrueType fonts

Avant Garde Dom Casual New Century Schoolbook
Bold

Avant Garde Bold Graphite Light New Century Schoolbook
Italic

Benguiat Frisky Graphite Light Narrow New Century Schoolbook
Bold/Italic

Bernhard Modern Helvetica Narrow Phyllis

Bookman Helvetica Narrow Bold Poster Bodoni

Bookman Bold Lucida Casual Signet Roundhand

Bookman Italic Lucida Casual Italic Torino Outline

Bookman Italic/Bold Milestones Zapf Chancery

Cooper Black New Century Schoolbook Zapf Dingbats

You can choose to install any or all of the 27 TrueType fonts contained on
these disks. Each font requires between 36K and 64K of hard disk space.



Installing and Using Fonts

To install the fonts:
1. Insert the HP Series Fonts Install disk.

2. Double-click the Installer icon.

3. Follow the instructions.

4. You must select your printer in the Chooser before you can print
using the newly installed fonts. (See instructions under the topic:
Using the Printer Driver.)

Installation Results

How the Font Installer Works

System 7.0 The Font Installer copies the font files to the System File in
the System Folder.

System 7.1 and greater The Font Installer copies the font files to the Fonts Folder in
the System Folder.

PostScript Compatibility

PostScript fonts are also compatible with your printer. Creating high-
quality output using Type 1 fonts requires Adobe Type Manager (ATM).

Font Priorities

If a system has both ATM and TrueType fonts installed, the printer driver
uses the following order to choose fonts for printing.

1. ATM fonts

2. TrueType fonts

3. Screen fonts (when no printer outline fonts are available.)

Note TrueType (and Type 1) fonts are variable-sized fonts,
sometimes called outline fonts. Bitmapped or screen fonts
are fixed size fonts.



Removing Fonts

If you have used previous HP printer drivers you may have fonts that you
no longer need.

To delete unneeded font folders:
1. Open the System Folder.

2. Open the Preferences Folder.

3. If you see a DeskWriter Fonts Folder or an HP Fonts Folder drag it
to the trash.

4. Choose Empty Trash from the Special menu.



Installing the Printer Driver

Before the printer can print, the software that enables the computer to
communicate with the printer must be installed; this software is the printer
driver.

HP DeskJet 850C/855C series printers come with a Driver Installation Disk
which contains printer drivers for both the QuickDraw and QuickDraw GX
environments. You need to decide which is appropriate for your printer
depending on your Macintosh system software and memory. Refer to
QuickDraw and QuickDraw GX under: Printing with the Macintosh for help
deciding which driver to install.

This section provides instructions for installing the QuickDraw printer
driver. The default installation procedure copies all the printer drivers and
background printing files contained on the HP Driver Installation Disk to
the correct locations in the System folder. If the installer finds a file with the
same name, it replaces it with the most current version.

System Requirements

HP DeskJet 850C/855C series QuickDraw printer drivers require a hard
disk, system software 7.0 or later, and at least 4 MB of RAM.

Installation Instructions

The Installer provides both easy and custom installation options. Easy
Install is the default. The Easy Install procedure installs all printer drivers
contained on the Driver Installation Disk. Use the Customize option to
install only specific drivers.



Printer Driver Installation Instructions
Installation
Procedure

Results Steps

Easy Install Installs all the printer
drivers on the disk into
the Extensions Folder.

1. Insert the Driver Installation Disk.
2. Double-click the Installer icon.
3. Verify that the hard disk indicated

is correct. If necessary, use the
Switch Disk button until the correct
hard disk appears.

4. Click Install to proceed with the
Easy Install option.

5. After the installation is complete,
restart the computer.

Customize Installs only specified
printer drivers into the
Extensions Folder.

6. Insert the Driver Installation Disk.
7. Double-click the Installer icon.
8. Verify that the hard disk indicated

is correct. If necessary, use the
Switch Disk button until the correct
hard disk appears.

9. Select Customize.
10. Select the driver(s) for your

printer(s).
11. Click Install.
12. After the installation is complete,

restart the computer.

Depending on the system software, the QuickDraw printer driver may
increase the Finder’s memory allocation.

Removing Extra Printer Drivers

Users with limited hard disk space may choose to remove printer drivers
not being used.

To remove extra printer drivers:
1. Open the System Folder.

2. Locate and open the Extensions Folder in the Systems Folder.

3. Click the icon for the printer driver you want to remove.

4. Drag the icon to the Trash, then choose Empty Trash from the
Special menu.

5. Close the Extensions Folder and the System Folder.



Choosing a Printer

Before printing, you must choose the HP DeskJet 850C/855C as the
printer you wish to use, even if it’s the only printer connected to your
computer. To do this, select Chooser from the Apple menu.

The QuickDraw Chooser Dialog Box

If the printer is connected directly to your computer:
1. Click the icon for the HP DeskJet 850C/855C.

2. Click the icon indicating to which port you connected the printer.
(Both the printer and modem ports are serial ports.)

If the printer is connected via a network:
1. Make sure AppleTalk is active.

2. Click the icon for the HP DeskJet 850C/855C.

3. If your network is divided into zones click the zone for your printer.

4. Select HP DeskJet 850C/855C.



About the Printer Driver

The print driver software communicates the printer’s features and design
to your computer. The HP ColorSmart technology within the HP printer
driver analyzes your documents for the best quality printout every time you
print. ColorSmart identifies each element on a page - text, graphics,
photographs - and automatically applies the appropriate colors and ink
amounts to each of them.

The DeskJet 850 C QuickDraw Printer Driver Provides:

27 TrueType fonts.

Laser-quality text and graphics printing in portrait and landscape
orientations.

Exceptional print quality even when mixing text and graphics on
the same page.

Near photographic quality when printing images. HP color printers
use ColorSmart technology allowing halftone pattern removal,
edge sharpening, and tone smoothing.

Print preview.

“Back to front” printing.

Multiple copy printing.

A default save for the print settings so that documents print the
same way every time.

Reduce or enlarge options. Reducing a document allows you to fit
the document’s contents to sizes corresponding to the printer’s
media capabilities . Enlarging a document allows you to more
easily see the documents contents. Reducing or enlarging a
document for printing does not affect the page dimensions in the
application.

Languages Supported

The QuickDraw and QuickDraw GX Printer Drivers Support:

English Italian Dutch

French Spanish Swedish

German Portuguese Japanese



Using the Printer Driver

The printer driver provides dialog boxes for communicating specific
printing instructions to the printer.

Select the general print settings, such as the paper size and type,
and the page orientation from within a software application by
choosing Page Setup from the File menu. This displays the Page
Setup dialog box.

Select specific print settings, such as intensity, halftoning patterns,
and color matching, from within the software application by
choosing Options from either the Page Setup or the Print dialog
boxes. This displays the Options dialog box. In general, leaving
the Options settings at Auto allows ColorSmart to provide the best
printing possible.

Page Setup

Before printing choose Page Setup from the File menu.

The Page Setup Dialog Box



Page Setup Options
HP DeskJet 850C/855C Page Setup Options

Media Size The pop-up menu displays selections supported by the
printer.

Media The media may be either plain paper or one of HP’s special
media types.

Orientation Portrait or landscape.

Reduce/Enlarge Valid range: 25% – 400%.

Save as Default Save the current settings as the default settings for the Page
Setup and ColorSmart options.

Service Opens the Service dialog box, which is used for print cartridge
maintenance.

Options Opens the ColorSmart Options dialog box which is used to
change some of the ColorSmart options.

Printing Documents

When printing from the Finder, you can select multiple documents for
printing in succession. These documents need not have the same
specifications nor have been created with the same software application.
The printing specifications for each document are used when that
document is printed. However, the printer does not notify you if the
documents require different sizes or types of paper. Choose Print from the
File menu to see the Print Dialog box.

How to Print

Two Ways to Access the Print Dialog

From within an application Choose Print from the File menu.

From the Finder Select the document you want to print by clicking on the
document icon(s) and choosing Print from the File menu.



The Print Dialog Box

Printing Options

HP DeskJet 850C/855C Print Options

Quality Best
Normal
EconoFast

Pages Print all pages or a specified range of pages.

Copies Print multiple copies of a document. (The range is 1 to 9999.)

Print Back to Front Print the last page of a document first so that the first page is
on top of the stack in the output tray. This provides
documents in the correct order when printing is complete

Print in Grayscale Print color documents in grayscale (black and white and
shades of gray).

Preview Display a preview of the printer output.

Options Provides access to the ColorSmart Options dialog.

Note If you choose the printing back to front option in both your
software application and the Print dialog box, the commands
cancel each other and the document prints front to back.



Background Printing

The background printing option enables you to work on other documents
while printing. When background printing is on, a copy of your document is
saved in the PrintMonitor Documents folder, a temporary folder in the
Systems folder on your hard disk. This copy is then sent to the printer.
Although background printing lets you regain control of your computer
sooner; the actual printing of the document is slower.

If you send several documents to the printer, a queue forms in the
PrintMonitor Documents folder. Documents print in the order received.

To use background printing, select the Chooser from the Apple menu,
select the printer you are using, and turn on background printing.

The HP PrintMonitor

Use the HP PrintMonitor during background printing to:

See which file is currently printing.

View and re-arrange the order of files waiting to be printed.

Cancel a file from printing.

Remove a file from the print queue.

Establish preferences for the level of notification used when the
printer needs attention.

Note You cannot directly print a file from the HP PrintMonitor. The
HP PrintMonitor prints in the background until the
PrintMonitor Documents folder is empty.



Using the PrintMonitor
To open the HP PrintMonitor

During background printing: Select HP PrintMonitor from the Application menu in the top
right corner of the menu bar.

When the printer is inactive: Double-click the HP PrintMonitor icon in the Extensions
folder.

Once the HP PrintMonitor is displayed, change the settings by choosing
Preferences from the File menu.

Note By default, the HP PrintMonitor is not displayed during
printing. To automatically display the HP PrintMonitor during
printing change the settings in the Preferences dialog box.



Optimizing Performance

The printer driver is designed to deliver the best possible performance.
However, printer output speed can be affected by the amount of available
system memory (RAM) and the amount of available disk space.

The following list provides ideas on how to enhance the printer’s
performance:

Increase the amount of RAM in your computer. The QuickDraw
printer driver requires at least 4 MB of RAM. Use additional
memory (5 MB or more) to increase the printer’s flexibility in using
applications.

Limit the number of documents and programs that you open at one
time.

Free system memory (RAM) by removing start-up screens, INITs,
and control panels from the System Folder.

Turn off background printing.

Decrease the Disk Cache in the Memory Control Panel.

Remove unneeded fonts.

Servicing the Print Cartridge

The printer software Service dialog box provides access to cleaning and
alignment routines. Use the cleaning routines only when necessary
because they use large amounts of ink.

To access the Service dialog box:
1. Choose Page Setup from the File menu.

2. Click Service.

Alternatively, select the desktop printer icon and click Print Cartridge
Cleaning or Print Cartridge Alignment from the Print menu.



The Service Dialog Box

Cleaning

HP DeskJet 850C/855C series printers provide multiple levels of
maintenance for cleaning the printer cartridge.

Clean, also referred to as “Surface Clean”

Standard Clean

Prime

Click Start to initiate the Clean process, then click Clean to initiate the
clean cycle. A test page prints after the cycle finishes.

If not satisfied with the results, continue with the Standard Clean cycle. A
test page prints after the Standard Clean finishes.

If still not satisfied, continue with the Prime procedure.

Caution Priming extracts large amounts of ink and should not be
performed as a routine operation.

Aligning

If necessary, click Align in the Service dialog box to align the color and
black cartridges with one another. HP recommends aligning each time
one of the cartridges is changed.



Troubleshooting

HP periodically provides updates of the printer software. These updates
may include enhancements that improve printer performance.

Problems and Solutions

Problem Solution

Printer won’t print. Open the Chooser and verify that the correct printer is
selected.

Printer icon does not appear
on the left side of the
Chooser.

Make sure that the printer is turned on.

Make sure that the printer driver icon is in the Extensions
Folder.

The printer name does not
appear on the right side of
the Chooser or the HP
DeskWriter family printer is
not listed.

Make sure the printer is turned on.

Open the Chooser and  make sure AppleTalk is active if
connecting to a network printer.

Power light is On, the
Resume light is Off.

Check that the printer appears in the Chooser then close all
applications and restart. If this doesn’t work it may be
necessary to reinstall the printer driver software.

Using Online Help

Two types of online help provide information about the printer software.

Printer Software Help

Type of help Provides How to access/where to find

Balloon Help Pop-up information about
options in the dialog
boxes when you move
the mouse cursor over
certain parts of the
screen.

1. Choose Show Balloons from the Help
menu in the upper right corner of the
menu bar. (If this option is not
available Balloon help is already on.)

2. To turn off Balloon help, choose Hide
Balloons from the Help menu.

ReadMe Files Release notes and
current information.

1. On the Driver Installation Disk.

2. On the Fonts Installation Disk.



Installing the Printer Driver

Before you print you must install the software that enables your computer
to communicate with the printer. This software is called the printer driver.

HP DeskJet 850C/855C series printers come with a Driver Installation Disk
which contains printer drivers for both the QuickDraw and QuickDraw GX
environments. You need to decide which is appropriate for your printer
depending on your Macintosh system software and memory. Refer to the
topic: QuickDraw and QuickDraw GX under the category: Printing with the
Macintosh for help deciding which driver to install.

This section provides instructions for installing the QuickDraw GX printer
driver. The default installation procedure copies all the printer drivers and
background printing files contained on the HP Driver Installation Disk to
the correct locations in the System folder. If the installer finds a file with the
same name it replaces it with the most current version

System Requirements

HP DeskJet 850C/855C series QuickDraw GX printer drivers require a
hard disk, system software 7.5 or later, and at least 8 MB of RAM.

Installation Instructions

The Installer provides both easy and custom installation options. Easy
Install is the default. The Easy Install procedure installs all printer drivers
contained on the Driver Installation Disk. Use the Customize option to
install only specific drivers.



Driver Installation Instructions
Installation
Procedure

Results Steps

Easy Install Installs all the printer
drivers on the disk into
the Extensions Folder.

1. Insert the Driver Installation Disk.
2. Double-click the Installer icon.
3. Verify that the hard disk indicated

is correct. If necessary, use the
Switch Disk button until the correct
hard disk appears.

4. Click Install to proceed with the
Easy Install option.

5. After the installation is complete,
restart the computer.

Customize Installs only specified
printer drivers into the
Extensions Folder.

1. Insert the Driver Installation Disk.
2. Double-click the Installer icon.
3. Verify that the hard disk indicated

is correct. If necessary, use the
Switch Disk button until the correct
hard disk appears.

4. Select Customize.
5. Select the driver(s) for your

printer(s).
6. Click Install.
7. After the installation is complete,

restart the computer.

Removing Extra Printer Drivers

Users with limited hard disk space may choose to remove printer drivers
not being used.

To remove extra printer drivers:
1. Open the System Folder.

2. Locate and open the Extensions Folder in the Systems Folder.

3. Click the icon for the printer driver you want to remove.

4. Drag the icon to the Trash, then choose Empty Trash from the
Special menu.

5. Close the Extensions Folder and the System Folder.



Choosing a Printer

Before printing you must choose the HP DeskJet 850C/855C as the printer
you wish to use, even if it’s the only printer connected to your computer.

1. Choose Chooser from the Apple menu.

The QuickDraw GX Chooser Dialog Box

2. Click the icon for the HP DeskJet 850C/855C printer.

3. If trying to connect to a network or Server printer, make sure
AppleTalk is active.

4. Use the Connect via: pull-down menu to select the type of I/O used
to communicate with the printer: Serial, AppleTalk, or Server.



Printer Connection Pull-down Menu
Connect via: When applicable:

Serial The printer is connected directly to the printer or modem port.

AppleTalk The printer is connected by a network.

Servers The printer is connected directly to another computer and is being shared
across the network.

4. If the computer is directly connected to the computer, specify
which port.

5. Close the Chooser.

Sharing Printers

With QuickDraw GX you can place an icon representing the printer on your
desktop. Desktop printer icons are necessary in order to share printers
with other network users. It is also a convenient way to use a printer no
matter where it is physically located.

Creating a Desktop Printer Icon

To create a desktop printer icon:
1. Choose Chooser from the Apple menu.

2. Select a printer.

3. Click Create. A printer icon appears on your desktop.

4. Close the Chooser.

To share the printer:
1. Click the icon for the printer to be shared.

2. Choose Sharing from the File menu.

3. Specify whether non-QuickDraw GX users can use the printer or
not.



Printer Icon Sharing Options
Sharing options

Non-QuickDraw GX systems may also use this
printer

Provides access to all specified network
users, groups, and guests.

Share this printer Provides access only to specified QuickDraw
GX users, groups, and guests.

User/Group, Guest Use the Users and Groups Control Panel
dialog box to restrict access to unqualified
users.

Deleting a Desktop Printer Icon

To delete a desktop printer, make sure the print queue is empty, then drag
the icon to the Trash.



About the Printer Driver

The print driver software communicates the printer’s features and design
to your computer. The HP ColorSmart technology within the HP printer
driver analyzes your documents for the best quality printout every time you
print. ColorSmart identifies each element on a page - text, graphics,
photographs - and automatically applies the appropriate colors and ink
amounts to each of them.

HP DeskJet 850C/855C series QuickDraw GX printer drivers provide:

Background or foreground printing.

Desktop printer icons.

Drag and drop printing to the desktop printer icon.

Printing status messages, allowing you to view the jobs in queue;
stop, pause, or remove jobs; change the printing order of the jobs
in queue.

Added options to the Print and Page Setup dialog boxes allowing
print quality control.

27 TrueType fonts.

Laser-quality text and graphics printing in portrait and landscape
orientations.

Exceptional print quality even when mixing text and graphics on
the same page.

Near photographic quality when printing images. HP color printers
use ColorSmart technology allowing halftone pattern removal,
edge sharpening, and tone smoothing.

Print preview.

“Back to front” printing.

Multiple copy printing.

A default save for the print settings so that documents print the
same way every time.

Reduce or enlarge options. Reducing a document allows you to fit
the document’s contents to sizes corresponding to the printer’s
media capabilities . Enlarging a document allows you to more
easily see the documents contents. Reducing or enlarging a
document for printing does not affect the page dimensions in the
application.



Languages Supported
The QuickDraw and QuickDraw GX Printer Drivers Support:

English Italian Dutch

French Spanish Swedish

German Portuguese Japanese



Using the Printer Driver

The printer driver provides dialog boxes for communicating specific
printing instructions to the printer.

Select the general print settings, such as the paper size and type,
and the page orientation from within a software application by
choosing Page Setup from the File menu. This displays the Page
Setup dialog box.

Select specific print settings, such as intensity, halftoning patterns,
and color matching, from within the software application by
choosing Options from either the Page Setup or the Print dialog
boxes. This displays the Options dialog box. In general, leaving
the Options settings at Auto allows ColorSmart to provide the best
printing possible.

Page Setup

Before printing choose Page Setup from the File menu.

The Page Setup Dialog Box

The page setup dialog box may look different depending on whether or
not the application being used recognizes QuickDraw GX. The QuickDraw
GX printer driver offers extra features.



Page Setup Options
HP DeskJet 850C/855C Page Setup Options

Media Size The pop-up menu displays selections supported by the printer.

Media The media may be either plain paper or one of HP’s special
media types.

Orientation Portrait or landscape.

Reduce/Enlarge Valid range: 25% – 400%.

Options Opens the ColorSmart Options dialog which is used to change
some of the ColorSmart options.

Printing Documents

When printing from the Finder you can select multiple documents for
printing in succession. These documents need not have the same
specifications nor do they need to have been created with the same
software application. The printing specifications for each document are
used when that document is printed. However, the printer does not notify
you if the documents require different sizes or types of paper. Choose Print
from the File menu to see the Print dialog box.

How to Print

Three Ways to Access the Print Dialog

From within an application Choose Print from the File menu.

From the Finder Select the document you want to print by clicking on the
document icon(s) and choosing Print from the File menu.

Drag and Drop Drag one or more files to the desktop printer icon.



The Print Dialog Box

Note If you choose the printing back to front option in both your
software application and the Print dialog box, the commands
cancel each other and the document prints front to back.



Background Printing

Turning the background printing option on enables you to work on other
documents while printing. When background printing is on, a copy of your
document is saved in the PrintMonitor Documents folder, a temporary
folder in the Systems folder on your hard disk. This copy is then sent to the
printer. Although background printing lets you regain control of your
computer sooner; the actual printing of the document is slower.

If you send several documents to the printer, a queue forms in the
PrintMonitor Documents folder. Documents print in the order received.

To use background printing, select the Chooser from the Apple menu,
select the printer you are using, and turn on background printing.

The HP PrintMonitor

With QuickDraw GX, access the PrintMonitor by double clicking the icon
for the printer. Use the HP PrintMonitor during Background Printing to:

See which file is currently printing.

View and re-arrange the order of files waiting to be printed.

Cancel a file from printing.

Remove a file from the print queue.

Establish preferences for the level of notification used when the
printer needs attention.

Note You cannot directly print a file from the HP PrintMonitor. The
HP PrintMonitor prints in the background until the
PrintMonitor Documents folder is empty.



Using the PrintMonitor
To open the HP PrintMonitor

During background printing: Select HP PrintMonitor from the Application menu in the top
right corner of the menu bar.

When the printer is inactive: Double-click the HP PrintMonitor icon in the Extensions folder.

Under QuickDraw GX with
desktop printer icons:

Double-click the desktop printer icon while printing.

Once the HP PrintMonitor is displayed, change the settings by choosing
Preferences from the File menu.

Note By default, the HP PrintMonitor is not displayed during
printing. To automatically display the HP PrintMonitor during
printing change the settings in the Preferences dialog box.



Optimizing Performance

The print driver is designed to deliver the best possible performance.
However, printer output speed can be affected by the amount of available
system memory (RAM) and the amount of available disk space.

The following list provides ideas on how to enhance the printer’s
performance:

Increase the amount of RAM in your computer. The QuickDraw GX
printer driver requires at least 8 MB of RAM. Use additional
memory (5 MB or more) to increase the printer’s flexibility in using
applications.

Limit the number of documents and programs that you open at one
time.

Free system memory (RAM) by removing start-up screens, INITs,
and control panels from the System Folder.

Turn off background printing.

Decrease the Disk Cache in the Memory Control Panel.

Remove unneeded fonts.

Servicing the Print Cartridge

The printer software Service dialog box provides access to cleaning and
alignment routines. Use the cleaning routines only when necessary
because they cause the print cartridges to use large amounts of ink.

To access the Service dialog box:
1. Choose Page Setup from the File menu.

2. Click Service.

Alternatively, select the desktop printer icon and click Print Cartridge
Cleaning or Print Cartridge Alignment from the Print menu.



Cleaning

HP DeskJet 850C/855C series printers provide multiple levels of
maintenance for cleaning the printer cartridge.

Clean, also referred to as “Surface Clean.”

Standard Clean

Prime

Click Start to initiate the Clean process, then Click Clean to initiate the
clean cycle. A test page prints after the cycle finishes.

Clean Print Cartridge Dialog Box

If not satisfied with the results, continue with the Standard Clean cycle. A
test page prints after the Standard Clean finishes.



Prime Print Cartridge Dialog Box

If still not satisfied, continue with the Prime procedure.

Caution Priming extracts large amounts of ink and should not be
performed as a routine operation.

Aligning

If necessary, click Align in the Service dialog to align the color and black
cartridges with one another. HP recommends aligning each time one of
the cartridges is replaced.



Troubleshooting

HP periodically provides updates of the printer software. These updates
may include enhancements that improve printer performance.

Problems and Solutions

Problem Solution

Printer does not print Open the Chooser and verify that the correct printer is
selected.

Printer icon does not appear
on the left side of the
Chooser.

Make sure the printer is turned on.

Make sure that the printer driver icon is in the Extensions
Folder.

The printer name does not
appear on the right side of
the Chooser.

Make sure the printer is turned on.

Open the Chooser and  make sure AppleTalk is active.

Power light is On, the
Resume light is Off.

Check that the printer appears in the Chooser then close all
applications and restart. If this doesn’t work it may be
necessary to reinstall the printer driver software.

Using Online Help

Two types of online help provide information about the printer software.

Printer Software Help

Type of help Provides How to access/where to find

Balloon Help Pop-up information about
options in the dialog
boxes when you move
the mouse cursor over
certain parts of the
screen.

1. Choose Show Balloons from the Help
menu in the upper right corner of the
menu bar. (If this option is not
available Balloon help is already on.)

2. To turn off Balloon help, choose Hide
Balloons from the Help menu.

ReadMe Files Release notes and
current information.

1. On the Driver Installation Disk.

2. On the Fonts Installation Disk.
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The Printing System

Printing systems contain hardware and software components which must
work together properly before printing can take place. The printer driver
provides the interface between the software applications that support
printing, the computer’s hardware, and the printer. The basic printing
system consists of the following:

1. Host computer (PC or Macintosh)

2. Application software (word processing, graphics design, desktop
publishing, etc.)

3. Printer driver (specific to your printer and, in some cases, your
application software)

4. Printer cable

5. Printer (HP DeskJet or DeskWriter)

6. The paper or other media upon which printing will take place

Note Printing systems in networks may contain a somewhat
different configuration of hardware and software.

HP ColorSmart printer drivers not only provide the hardware/software
interface, but also allow bi-directional communication between the printer
and the computer.  Bi-directional communication allows printing
information to flow from the computer to the printer, and printer status and
error information to flow back from the printer to the computer.

Resolving Printing System Problems

Many printer problems and their solutions are reported in error messages
that appear on the computer’s screen.  When one of these messages is
received, follow the instructions given.  Check the HP DeskJet Status
Monitor (MS Windows users) or the Print Monitor (Macintosh) for
information on the current status of the printer.

If you haven’t received an error message on the computer’s screen but
have noted a problem with your printer, read through the troubleshooting
topics that follow to find one that matches your printer’s symptoms.
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Troubleshooting Hints

The table below describes DeskJet and DeskWriter printing system
problems along with their causes and solutions.

Note To save time diagnosing printing system problems, the
Possible Cause column in the table below is given with the
most likely cause listed first. If the printing system does not
respond correctly after trying the first solution, proceed the
next, etc.

Printing System Problems, Causes and Solutions

Problem Possible Cause Solution

Printer does
not print.
(Power light on,
Form Feed
light off)

The printer driver is
still preparing data
to send to the
printer.

Wait a few minutes.  Some computers take several
minutes of processing time before sending any data
to the printer.

The interface
connection or the
interface cable has
failed.

1.  Verify the interface cable is an approved interface
cable. (Must conform to IEEE 1284-B standards)

2.  The interface cable may be faulty.  Check the
interface cable connections or try another
interface cable.

3.  Wrong interface connection.  For example, the
printer is connected to the serial port (e.g. COM1)
rather than a parallel interface port.

Failure of the host
computer.

1.  Verify the host is operating correctly by printing
to another printer.

2.  The computer-to-printer connection has failed.
Unplug the printer from the host computer and try
printing a self-test. If the self-test prints OK,
verify the host computer and interface cable are
functional by printing to a different printer using
the same printer port and printer cable.

The problem is
caused by TSR
programs or the
application
software.

1.  Close (or “rem-out”) any screen saver or other
TSR (Terminate Stay Resident) software
programs (such as MacDisk) that are open and
running in the background.  Restart your
computer.

2.  Your software program is not set up for the
printer.  Follow the instructions in your software
program manual for setting up the software to run
with the printer.

Continued on next page
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Printing System Problems, Causes and Solutions (Cont.)

Problem Possible Cause Solution

Printer does
not print.
(Cont.)
(Power light is
on, the Form
Feed light is
off)

The wrong printer is
selected

(MS Windows) Open the Printers dialog box in the
MS Windows Control Panel and verify that the
correct printer is selected. (An on-screen message
may ask you to open Page Setup in your
application.)

(Macintosh) Open the Chooser, select the correct
printer, and close the Chooser.  (An on-screen
message may ask you to open Page Setup in your
application.)

The problem is
caused by the
printer driver.

It may be necessary to reinstall the printer driver
software using the instructions from the setup card.

The printer’s name
does not appear in
the Installed
Printers list in the
Printers dialog box
in the MS Windows
Control Panel.

1.  Close all TSRs (screen savers and other software
that runs in the background).

2.  Exit and then restart MS Windows.

3.  Verify all TSRs remained closed.

4.  Reinstall the printer driver using the instructions
from the setup card.

The problem is
caused by the
application
software or the
printer driver.

1.  Restart Windows and print the self-test from the
HP Toolbox.

2.  Verify the proper printer driver and parallel port
are selected.  The printer driver’s name should
appear in the Installed Printers dialog box.

3.  Close any screen saver or other TSR (Terminate
Stay Resident) software programs that are open
and running in the background.  Restart your
computer.

4.  It may be necessary to reinstall the printer driver
software using the instructions from the setup
card.

5.  Your software program is not set up for the
printer.  Follow the instructions in your software
program manual for setting up the software to run
with the printer.

Continued on next page
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Printing System Problems, Causes and Solutions (Cont.)

Problem Possible Cause Solution

The printer does
not print.
(All lights are
blinking)

The printer-to-
computer
connection failed.

1.  Switch off the printer, disconnect the printer
cable, switch the printer on.

2.  If the Power light comes on and the Form Feed
light remain off, print a sample page.

3.  If the sample page prints, the printer is not the
problem.

4.  Reconnect the printer cable and re-send the file.

5.  If the problem persists, the problem may be with
the printer cable, the cable connections, or the
computer port.  (First, try another printer cable.)

The printer has
failed.

1.  Switch off the printer, disconnect the printer
cable, switch the printer on.

2.  If all lights begin blinking again, the printer is
faulty.

The printout
contains garbled
or strange text
characters (such
as hearts or
smiling faces), or
contains
distorted graphic
images.

The wrong printer
may be selected.

Verify that the proper printer driver is selected.  The
printer driver’s name should appear in the installed
printer’s dialog box (MS Windows) or the Chooser
menu (Macintosh).

The printer-to-
computer
connection failed.

1.  Switch off the printer, disconnect the printer
cable, and switch the printer on.

2. Print a self-test (or demo) page.

3.  If the self-test page prints, the printer is not the
problem.

4.  Reconnect the printer cable and re-send the file
to the printer.

5.  If the printout is still garbled, the problem may be
with the printer cable, the cable connections, or
the computer host. Try another printer cable. Try
a different computer.

The paper does
not eject from the
printer.

The printer did not
receive a form-
feed command.

If the software does not send automatic form-feed
commands, press the Form Feed key on the printer
to initiate a manual form-feed.

Continued on next page
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Printing System Problems, Causes and Solutions (Cont.)

Problem Possible Cause Solution

The colors in the
printout do not
match the colors
on the host
computer’s
monitor.

The printer driver
settings may not be
correct for your
monitor.

Verify that your print cartridges are at room
temperature and have plenty of ink, then try the
following:

1.  Verify that Complex Color Printing or Color
Match option is selected in the Options menu of
the Printer Setup menu.

2.  Try a different dithering method.  See the “User’s
Guide” for your printer for dithering
recommendations.

The printout
contains faint or
fuzzy print.

The printer driver
settings, the pens,
or the selected
media may be
faulty.

Verify the print cartridges are at room temperature,
and have plenty of ink.  Verify that the print
settings are appropriate for the media selected.
Make sure the correct print settings are selected in
the printer driver. (The printer driver settings should
appear in the Installed Printers dialog box.)
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Printer Troubleshooting Hints

Troubleshooting Tools

The following table lists the tools needed for general printer
maintenance.

Recommended Troubleshooting Tools and Supplies

Tool Purpose

Tissue Print Cartridge Cleaning Operations.

Lint -free cloth Cleaning the Printer and the Print Cartridge Contacts.

Computer vacuum Loosening and removing paper dust and other particulate matter
from the interior of the printer.

Distilled water Used for all cleaning purposes requiring water.

HP Toolbox (MS Windows Users)

HP Toolbox helps you diagnose and solve common printing problems.
To access HP Toolbox, double-click the Toolbox icon in the HP DeskJet
Utilities program group.  Then follow the symptoms and solutions that
apply.

Note Instead of the HP Toolbox, earlier versions of MS Windows
printer drivers used Dr. DeskJet which performed similar
functions. To access Dr. DeskJet, double-click the Dr.
DeskJet icon in the HP DeskJet Utilities program group.
Then follow the symptoms and solutions that apply.
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Troubleshooting Flowcharts

Troubleshooting Flowcharts - Power-On Section

Return for service.
See "CSP200"
customer code.

See "EX" and "EZ" See "CSP200"

Start

Turn on the printer.

Power light
turns on?

No

Yes

   1. Verify the power module is plugged into a powered AC receptacle.
   2. Verify the power module is plugged into the printer.
   3. Check the power module with another printer.
   4. Unplug the interface cable.

Power light
turns on?

Yes No
Return for service.
See "CSP100" and
“CSP210” customer
codes.

Printer noisy?

Carriage Moves
 & Power/Ready

 light on

Go to the
Self-Test section
of the Flowchart

Power-On Sect ion

   1. Check for obstructions or loose parts.
   2. Determine noise is excessive for product.

Still Noisy?
Return for service. See
"CPN100" or “CPN105”
customer codes.

1. Check for carriage obstruction.
2. Check for missing/incorrect print cartridge.

1. Verify the computer is on.
2. Disconnect the printer from the computer.

Control panel
 light(s) flashing?

Flashing?

Still flashing?
See Printer Diagnostic Information/Error Light
Indications. See "CSP205", and "CSP215" customer
codes.

No

No

NoNo

No

No

Yes

Yes

YesYes

Yes

Yes

 steady?
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Troubleshooting Flowcharts - Self-Test Section

Run the printing
self-test.

Does
the self-test match

the example in Printer
Diagnostic

Information?

No

Yes

Is the print
quality good?

Yes See Print Quality Problems.
See "CGT100” through
“CPG115" customer codes.

Printer noisy?

Go to the Macintosh or
 PC Connect Sections

of the Flowchart

Self-Test  Sect ion

1. Check for obstructions or loose parts.
2. Determine noise is excessive for product.

Still Noisy?
Return for service. See
"CPN100" and CPN105”
customer codes.

No

No

Yes

Yes

Control panel
lights flashing?

See Printer Diagnostic Information/Error Light
Indications. See "CSP205" and “CSP215
customer codes.

Is the printout
complete?

Return for service. See
"CGT100" through “CPG115”
customer codes.

No

No

No

Yes

Yes
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Troubleshooting Flowcharts - PC Connect Section

No

Yes

No

No

No

Yes

Yes

Yes

From the Self-Test
Section

Can standard
ASCII text be printed

(dir, edit)?

Print ASCII text?
Return for service. See
“CKK100 “ and “CKK105”
customer  codes.

Print from
 an MS Windows

Application?

At this point, the
printer should be
operating normally.
However, if it is not,
return it for service
along with a complete
description of the
problem.

PC Connect  Sect ion

1. Check that the driver version is correct.
2. Check the configuration in the MS Windows control panel.

Print from MS
Windows?

Return  printer for service and
document the error and its
symptoms.  See “Warranty and
Support Information”  for
customer code information.

1. Reconnect the interface cable.
2. Try another interface cable.
3. Verify the printer and computer are properly configured.
4. Try the printer with another computer.
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Troubleshooting Flowcharts - Macintosh Connect Section

  Macintosh Connect  Sect ion

From the Self-Test
Section

Prints from a
Macintosh Computer?

Yes

Print ok?
Return for Service. See
“CKK100 “ and “CKK105 "
customer codes.

At this point, the printer
should be operating
normally. However, if it
is not, return the printer
for service and
document the error and
its symptoms.  See
“Warranty and Support
Information”  for
additional customer code
information.

NoYes

1. Verify the correct printer is selected in the Chooser (AppleTalk or Serial).
2. If AppleTalk, verify that AppleTalk is  active in the Chooser.
3. If connected serially, verify that AppleTalk is inactive in the Chooser.
4. Verify the correct port is selected in the Chooser.
5. Reconnect the interface cable.
6. Try another interface cable.
7. Try the printer with another computer.

No
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MacIntosh Troubleshooting

Note HP periodically provides updates of the printer software.
These updates may include enhancements that improve
printer performance.

Problems and Solutions

Problem Solution

Printer won’t print Open the Chooser and verify that the correct printer is
selected.

Printer icon does not appear
on the left side of the
Chooser.

Make sure that the printer is turned on.

Make sure that the printer driver icon is in the Extensions
Folder.

The printer name does not
appear on the right side of
the Chooser or the HP
DeskWriter family printer is
not listed.

Make sure the printer is turned on.

Open the Chooser and make sure AppleTalk is active.

Power light is On, the
Resume light is Off.

Check that the correct printer is in the Chooser, then close all
applications and restart. If this doesn’t work it may be
necessary to reinstall the printer driver software.



P r i n t e r  I n t e r f a c e  I n f o r m a t i o n H P  D e s k J e t  P r i n t e r s 

HP DeskJet Printers

Cable and Connector Information

Recommended Interface Cables

Host Interface
HP Cable

Part Number Cable Length Cable Connectors

HP IEEE-1284
Compliant Cable

C2950A 2 Meters DB-25 Male to 36-Pin
Centronics Male

HP IEEE-1284
Compliant Cable

C2951A 3 Meters DB-25 Male to 36-Pin
Centronics Male

Interface Specifications

HP DeskJet printers communicate with computers through a single
IEEE1284-B parallel I/O interface connector. For more information about
interface connection and operation, see “DOS I/O Interface Description.”

Communication Modes and Supported Protocols

Category Specification

Interface Protocol IEEE-1284 Compatible

Communication Modes Available Compatible (Centronics)
Nibble
ECP
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IEEE-1284 Interface Connector

1234567891011121318 17 16 15 14

25 24 23 22 21 20 192627282930313233343536

2162989

IEEE-1284 Interface Port (DOS/MS Windows)

Pin
Number Source

Compatibilit
y Mode

Nibble
Mode

ECP
Mode

1 Host nStrobe HostClk HostClk

2 Bi-Directional Data 1 (LSB)

3 Bi-Directional Data 2

4 Bi-Directional Data 3

5 Bi-Directional Data 4

6 Bi-Directional Data 5

7 Bi-Directional Data 6

8 Bi-Directional Data 7

9 Bi-Directional Data 8

10 Bi-Directional nAck PrtClk PeriphClk

11 Bi-Directional Busy PrtBusy PeriphAck

12 Bi-Directional PError AckDataReq nAckReverse

13 Bi-Directional Select Xflag Xflag

14 Host nAutoFd HostBusy HostAck

15

Continued on next page
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IEEE-1284 Interface Port (DOS/MS Windows) (Cont.)

Pin
Number Source

Compatibility
Mode

Nibble
Mode

ECP
Mode

16 Logic Gnd

17 Chassis Gnd

18 Peripheral Peripheral Logic High

19 Signal Ground (nStrobe)

20 Signal Ground (Data 1)

21 Signal Ground (Data 2)

22 Signal Ground (Data 3)

23 Signal Ground (Data 4)

24 Signal Ground (Data 5)

25 Signal Ground (Data 6)

26 Signal Ground (Data 7)

27 Signal Ground (Data 8)

28 Signal Ground
(Perror, Select, nAck)

29 Signal Ground
(Busy, nFault)

30 Signal Ground
(nAuto Fd, nSelectLn, nInit)

31 Host nInit nInit nReverseRequest

32 Peripheral nFault nDataAvail nPeriphRequest

36 Host nSelectLn 1284 Active 1284 Active
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DOS I/O Interface Description

The IEEE-1284 standard defines a signaling method for bi-directional
parallel communications between hosts and printers or other peripheral
devices. This standard provides improved performance and bi-directional
(two-way) communication, allowing a new generation of "intelligent"
peripherals to talk and listen to the host device.

HP DeskJet printers have an IEEE 1284-B parallel I/O interface
connector. This interface adheres to the IEEE 1284-B parallel interface
standard which was derived from the earlier "Centronics®" interface.
Firmware in HP DeskJet printers support the following modes of
operation through the IEEE 1284-B parallel interface port:

Compatibility Mode

Nibble Mode

Extended Capabilities Port (ECP) mode

Printer drivers on host computers "negotiate" with the printer to switch
from one mode to another. If an error occurs while in Nibble or ECP
mode, the interface automatically reverts to Compatibility mode.

HP DeskJet printer drivers meet the IEEE 1284-B standard for Level 1
devices. Input receivers meet the standard for Level 2 devices. This
allows HP DeskJet printers to be connected to either a Level 1 or Level 2
host.

Level 1 devices drive the interface with 5 V TTL circuits. Their
requirements are consistent with pre-existing installed devices and they
can operate with any other Level 1 compliant device. Level 1 devices are
characterized by steady-state electrical specifications.

Level 2 devices use output drivers with 45-55 ohms output impedance
and TTL receivers with 0.2 V- 1.2 V hysteresis. Level 2 devices capitalize
on the transmission-line characteristics of the connecting cable,
providing faster data transmission.

Compatibility Mode

Compatibility mode is a unidirectional mode of operation in which data
flows from the host computer to the printer. It is the mode that has, in the
past, been called “Centronics.”
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Nibble Mode

Nibble mode is a unidirectional mode of operation in which data moves
from the printer to the host computer. HP DeskJet printers and most
computer hosts can operate in nibble mode. Hosts can switch back and
forth between compatibility and nibble modes, thus establishing limited
two-way (bi-directional) communication. The host must place itself and
the printer into nibble mode to receive status from the printer. This type of
bi-directional communication has previously been called “Bitronics.”

ECP Mode

ECP mode provides a true bi-directional link between the printer and the
host computer. HP DeskJet printers and most computer hosts can
operate in ECP mode. ECP mode, combined with the HP proprietary
communication protocol, allows the Remote Control Panel for DOS and
the HP DeskJet Status Monitor for MS Windows to receive and display
status information from the printer.
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HP DeskWriter Printers

Cable and Connector Information

Recommended Interface Cables

Cable Type HP Cable Part Number Apple Cable Part Number

AppleTalk Network 92215N M2068

RS-422-A High-Speed
Clocked Serial

92215S M0197

Interface Specifications

HP DeskWriter printers have an 8-pin mini-DIN interface connector port.
This connector port is compatible with RS-422-A serial, AppleTalk, and
high-speed externally-clocked serial mode communication. The printer
automatically determines if it is connected to an AppleTalk network or
directly to a Macintosh printer port.

Communication Modes and Supported Protocols

Category Macintosh I/O Connector

Communication Modes RS-422-A High-speed Serial

AppleTalk (230.4 Kbaud)

Macintosh Protocols Serial Pacing Protocol (SPP)

AppleTalk Transaction Protocol (ATP)

AppleTalk Link Access Protocol (ALAP)

Datagram Delivery Protocol (DDP)

Echo Protocol (EP)

Name Binding Protocol (NBP)

Printer Access Protocol (PAP)

Routing Table Maintenance Protocol (RTMP)
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RS-422 Interface Connector (8-pin Mini-DIN)

RS-422 Interface Port (AppleTalk)

Pin Number Interface Pin Name Interface Pine Description

1 DTR Data Terminal Ready Output Handshake

2 NC No Connection in Printer
(Do not connect to ground or any other pin)

3 TxD- Transmit Data Line

4 Ground Shield Ground

5 RxD- Receive Data Line

6 TxD+ Transmit Data Line

7 NC No Connection

8 RxD+ Receive Data Line

Note HP DeskWriter printer interface ports conform to RS-422 and
cannot be configured to operate as RS-232-C.

TxD+

RxD+

TxD-

RxD-

Ground

HSKo or DTR1
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Mac I/O Description

HP DeskWriter printers detect and monitor which interface mode (serial
or LocalTalk) is present, and automatically switch to the appropriate
protocol. The printers determine if they are connected to a LocalTalk
node by detecting the presence or absence of a transformer at the
interface connector port. (A transformer detected at the interface
connector indicates the printer is connected to an LocalTalk network.) If
the mode changes while the printer is on, the printer restarts.

HP DeskWriter printers are compatible with two Macintosh serial
interface modes:

RS-422-A (57.6 Kbaud)

Clocked

RS-422-A signals are modulated against an inverted copy of the
modulated signal (for example RxD- and RxD+). Data communication
occurs by sensing which line is more negative than the other. Sensing
line polarity in respect to an inverted signal is more immune to
interference and noise than to a signal compared to a common ground.
The signal is also less likely to degrade over longer cable distances.

If a serial connection is made and "clocked" mode is detected, the printer
switches from DTR mode (the default at power-up ) to SPP mode. The
printer selects a frequency for the clocking and clocks the DTR line at that
frequency.

In AppleTalk mode, the printer receives data in a synchronous serial bit
stream at 230.4 K bits per second and converts the data to parallel.

Note The Macintosh I/0 connector is RS-422-A compatible. It is
not possible to use this port as an RS-232-C serial
interface port.


